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Gwarancja 
 
Firma Tektronix gwarantuje, że wytwarzany i sprzedawany przez nią produkt będzie wolny od wad materiałowych i 
produkcyjnych przez 1 (jeden) rok licząc od daty jego dostawy. Jeżeli jednak zdarzy się , że podczas tego okresu produkt 
okaże się  wadliwy, firma Tektronix według własnego uznania dokona bezpłatnej naprawy (części i robocizna) lub zapewni 
wymian ę uszkodzonego przyrządu na warunkach podanych w pełnej umowie gwarancyjnej. Części zamienne, moduł y i 
zamienniki użyte przez firmę Tektronix do napraw gwarancyjnych mogą być nowe lub odnowione do stanu takiego, jak nowe. 
Wszystkie wymienione części, moduły i produkty stają się własnością firmy Tektronix. 

Aby uzyskać usługę serwisową w ramach niniejszej gwarancji, klient musi powiadomić firmę Tektronix przed wygaśnięciem 
niniejszej umowy gwarancyjnej oraz dokonać odpowiednich uzgodnień dotyczących usługi naprawy. Klient jest 
odpowiedzialny za opakowanie i dostarczenie uszkodzonego produktu do centrum serwisowego wyznaczonego przez firmę 
Tektronix. Koszty przesyłki muszą być opłacone z góry przez klienta. Firma Tektronix pokryje koszty odesłania produktu do 
klienta, jeśli miejsce przeznaczenia znajduje się w kraju, w którym jest położone centrum serwisowe firmy Tektronix. W 
przypadku produktów, które mają być odesłane w inne miejsce, klient pokrywa wszystkie koszty wysyłki, cła, podatki i inne 
opłaty. 

W stosunku do defektów, błędów lub uszkodzeń spowodowanych przez nieodpowiednie użytkowanie lub nieodpowiednią 
obsługę lub obchodzenie się z przyrządem. Firma Tektronix nie jest zobowiązana do zapewnienia usług gwarancyjnych w 
przypadku: a) naprawy uszkodzeń powstałych w wyniku prób instalacji, naprawy lub serwisu produktu dokonywanych przez 
personel inny niż autoryzowany przez firmę Tektronix, b) naprawy uszkodzeń wynikających z nieodpowiedniego użycia lub 
podłączenia przyrządu do nieodpowiedniego wyposażenia, c) naprawy uszkodzeń lub nieprawidłowego działania 
powodowanego przez użycie materiałów spoza firmy Tektronix, d) naprawy produktu, który został zmodyfikowany lub 
zintegrowany z innymi produktami, co w efekcie spowodowało zwiększenie czasu bądź zwiększyło trudności w naprawie 
produktu. 

NINIEJSZA GWARANCJA JEST UDZIELANA PRZEZ FIRMĘ TEKTRONIX W ODNIESIENIU DO PRODUKTU ZAMIAST 
INNYCH GWARANCJI, WYRAŻONYCH LUB UKRYTYCH. FIRMA TEKTRONIX NIE UZNAJE ŻADNYCH INNYCH  
UKRYTYCH GWARANCJI HANDLOWYCH LUB ZWYCZAJOWYCH WYNIKAJ ĄCYCH ZE SZCZEGÓLNYCH POWODÓW. 
ODPOWIEDZIALNOŚĆ FIRMY TEKTRONIX POLEGAJĄCA NA NAPRAWIE LUB WYMIANIE NIESPRAWNYCH 
PRODUKTÓW JEST JEDYNYM I WYŁĄCZNYM ŚRODKIEM ZAPEWNIENIA PRAW KLIENTA W PRZYPADKU 
NARUSZENIA NINIEJSZEJ GWARANCJI. FIRMA TEKTRONIX I JEJ PODDOSTAWCY NIE ODPOWIADAJĄ ZA ŻADNE 
SZKODY POŚREDNIE, SPECJALNE, PRZYPADKOWE LUB UMYŚLNE, BEZ WZGLĘDU NA TO CZY ZOSTALI 
WCZEŚNIEJ POWIADOMIENI O MOŻLIWOŚCI WYSTĄPIENIA TAKICH SZKÓD. 
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Ogólne zasady bezpieczeństwa 
 

 
W celu uniknięcia wypadku lub uszkodzenia przyrządu i dołączonych do niego urządzeń należy zapoznać się z 
podanymi niżej zasadami bezpieczeństwa. Przyrząd należy użytkować tylko zgodnie z niniejszą instrukcją.  

 
Prace serwisowe mogą być wykonywane wyłącznie przez wykwalifikowany personel. 

 
Unikanie pożaru lub uszkodzenia ciała 

 
Odpowiedni przewód sieciowy. Należy stosować tylko przewody zalecane do danego wyrobu i dopuszczone do 
użytkowania na terenie kraju użytkowania. 

Właściwe podłączanie i odłączanie. Nie dołączać lub odłączać sond i przewodów odniesienia kiedy są 
podłączone do źródeł napięcia. 

Uziemienie przyrządu. Przyrząd jest połączony z uziemieniem poprzez przewód ochronny w przewodzie 
zasilającym. Aby uniknąć porażenia przewód ten powinien być połączony z przewodem ochronnym sieci. Przed 
dołączeniem innych urządzeń do wejść i wyjść oscyloskopu należy upewnić się, że przyrząd jest poprawnie 
uziemiony. 

Przestrzeganie parametrów znamionowych. Aby uniknąć pożaru lub porażenia należy zwracać uwagę na 
nominalne parametry urządzeń. Przed dołączeniem ich do przyrządu należy sprawdzić parametry podane w 
specyfikacji lub instrukcji użytkownika.   

Przewód odniesienia sondy należy dołączać tylko do punktów uziemionych. 

Odłączanie zasilania. Wyłącznik zasilania odłącza przyrząd od źródła zasilania. Jego lokalizacja podana jest w 
instrukcji. Nie wolno blokować wyłącznika zasilania; musi on być stale dostępny dla użytkownika. 

Nie używać przyrządu bez obudowy. Nie używać przyrządu ze zdjętą lub otwartą obudową. 

Zakaz pracy przy zauważonym uszkodzeniu. Jeżeli użytkownik podejrzewa, ze przyrząd jest uszkodzony, 
powinien przekazać go do przeglądu w autoryzowanym serwisie. 

Unikanie otwartych obwodów. Nie należy dotykać otwartych obwodów lub elementów jeśli zasilanie jest 
włączone. 

Zakaz pracy w otoczeniu o dużej wilgotności. 

Zakaz pracy w atmosferze wybuchowej. 

Utrzymanie w czystości zewnętrznych elementów przyrządu. 

Zapewnienie odpowiedniego chłodzenia. Szczegółowe wymagania dotyczące chłodzenia przyrządu podane są 
w instrukcji obsługi. 
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Oznaczenia stosowane w instrukcji 

W instrukcji stosowane są następujące oznaczenia: 
 
OSTRZEŻENIE. Oznaczenie to służy do wskazania warunków lub czynności, które mogą stanowić zagrożenie dla 
zdrowia lub życia. 

 
WAŻNE. Oznaczenie to służy do wskazania warunków lub czynności, które mogą być przyczyną uszkodzenia 
przyrządu lub innych urządzeń. 

 

Oznaczenia i symbole umieszczone na przyrządzie 

W przyrządzie mogą wystąpić następujące oznaczenia opisowe: 

■   DANGER (niebezpieczeństwo) oznacza miejsce stwarzające bezpośrednie zagrożenie zdrowia lub życia 

■   WARNING (ostrzeżenie) oznacza miejsce niebezpieczne, nie stwarzające bezpośredniego zagrożenia zdrowia 
lub życia. 

■   CAUTION (uwaga) wskazuje na możliwość uszkodzenia przyrządu i innych urządzeń. 

Na przyrządzie stosowane są następujące oznaczenia symboliczne: 

 

       
UWAGA 

sprawdź w 
instrukcji 

OSTRZEŻENIE 
Wysokie napięcie 

Zacisk 
uziemienia 

ochronnego 

Zacisk masy 
pomiarowej 

Uziemienie 
chassis 

Czuwanie 
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Uwagi dotyczące ochrony środowiska 
 

W tej sekcji zawarte są informacje dotyczące wpływu przyrządu na środowisko. 
 

Postępowanie ze zużytym przyrządem 

W przypadku recyklingu przyrządu lub jego elementów należy przestrzegać następujących wytycznych: 

 

Recykling. Produkcja tego sprzętu wymagała wydobycia i wykorzystania zasobów naturalnych. Produkt może 
zawierać substancje szkodliwe dla środowiska i zdrowia ludzkiego. Aby uniknąć uwolnienia tych substancji do 
środowiska i zmniejszyć zużycie zasobów naturalnych zachęcamy do recyklingu przyrządu w odpowiednim 
systemie, dzięki któremu większość materiałów będzie mogła być wykorzystana ponownie. 

Poniższy symbol oznacza, że produkt spełnia przepisy Unii Europejskiej zgodne z dyrektywą 2002/96/EC 
dotyczącej odpadów sprzętu elektrycznego i elektronicznego (WEEE). Informacje dotyczące opcji recyklingu 
dostępne są na internetowej stronie producenta (www.tektronix.com) w sekcji support/service. 

 
 

 

 

Elementy zawierające rtęć. W przyrządzie wykorzystywana jest lampa podświetlająca ekran LCD, która zawiera 
rtęć. Warunki utylizacji mogą być określone przez przepisy dotyczące ochrony środowiska. Więcej informacji 
dotyczących utylizacji i recyklingu można uzyskać w lokalnych organach władzy lub, na terenie Stanów 
Zjednoczonych, w Electronics Industries Alliance (www.eiae.org).  

 

Ograniczenia dotyczące zawartości substancji niebezpiecznych. 
Produkt został sklasyfikowany jako aparatura kontrolno pomiarowa i jest poza zakresem stosowania dyrektywy 
2002/95/EC RoHS. Produkt zawiera ołów, kadm, rtęć oraz sześciowartościowy chrom. 
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Wstęp 
 
 
Niniejsza instrukcja zawiera informacje dotyczące instalacji i użytkowania przyrządów serii DPO7000. 
Przedstawione są podstawy obsługi oraz zasada działania. Więcej szczegółowych informacji znajduje się w 
systemie pomocy online przyrządu. Niniejsza instrukcja dotyczy przyrządów: 

■   DPO7254 

■   DPO7104 

■   DPO7054 
 

Kluczowe właściwości 
Seria przyrządów DPO7000 pomaga weryfikować, wyszukiwać błędy i badać projekty elektroniczne. Kluczowe 
właściwości obejmują: 

■  Pasmo 2,5 GHz i próbkowanie 10 GS/s w czasie rzeczywistym we wszystkich kanałach, 40 GS/s w jednym   
kanale, DPO7254 

■  Pasmo 1 GHz i próbkowanie 5 GS/s w czasie rzeczywistym we wszystkich kanałach, 20 GS/s (40 GS/s  
opcjonalnie) w jednym kanale, DPO7104 

■   Pasmo 500 MHz i próbkowanie 2,5 GS/s w czasie rzeczywistym we wszystkich kanałach, 10 GS/s (20 GS/s  
opcjonalnie) w jednym kanale, DPO7054 

■   Rekord o długości do 400,000,000 próbek, zależnie od modelu i opcji 

■   Do 1% dokładności wzmocnienia DC 

■   Cztery kanały wejściowe (każdy o rozdzielczości 8 bitów kiedy wyłączone jest HiRes) dodatkowe wejście i  
wyjście wyzwalania 

■  Tryby akwizycji: próbkowanie, obwiednia, detekcja pików, wysoka rozdzielczość, baza danych przebiegu, 
uśrednianie oraz szybka akwizycja FastAcq 

■  Pełna programowalność z zestawem poleceń GPIB i interfejsem bazującym na wiadomościach. 

■  Tryby wyzwalania obejmujące: zbocze, wyzwalanie logiczne, impuls, wybierane dla dwóch obwodów 
wyzwalania  A i B. Tryb wyzwalania oknem wyzwala gdy sygnał znajduje się wewnątrz lub zewnątrz 
zdefiniowanego obszaru okna. Wyzwalanie stanami logicznymi. Jitter wyzwalania mniejszy niż 1,5 ps RMS 
(typowo), zależnie od modelu. Możliwośc wyzwalania glitchem lub impulsem węższym niż 200 ps. Wyzwalanie 
sygnałami transmisji szeregowej, w tym wzorcami bitowymi. 

■    Wbudowane właściwości pomiarowe obejmujące histogramy, pomiary automatyczne, diagramy oka oraz 
pomiary statystyczne 

■    Przebiegi matematyczne wraz z filtrami użytkownika dopasowane do specyficznych zadań analitycznych. 
Analiza widmowa przebiegów w dziedzinie częstotliwości 

■   Duży 12.1’’ kolorowy wyświetlacz o rozdzielczości XGA obsługujący kolorową gradacje przebiegów, obrazującą 
zagęszczenie próbek. Ekran o rozmiarze 10 działek w osi pionowej i poziomej 

■   Powiększanie MultiView Zoom do obserwacji i porównania do czterech obszarów w tym samym czasie. 
Blokowanie, ręczne lub automatyczne przewijanie do czterech powiększonych obszarów 

■  Dostosowywane przez użytkownika okna konfiguracyjne MyScope 

■  Intuicyjny, graficzny interfejs użytkownika (UI) z wbudowanym systemem pomocy online 

■  Wewnętrzna, wyjmowalna pamięć dyskowa 

■  Szeroka gama dostępnych sond 
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Dokumentacja 
Różne informacje o produkcie dostępne są w poniższych dokumentach. 

 

Aby dowiedzieć się o Przeczytaj następujący dokument 

Instalacji i obsłudze Instrukcja użytkownika zawierająca ogólne zasady obsługi. 

Szczegółowych informacjach dotyczących 
obsługi i interfejsu użytkownika 

Pomoc online. Zawiera szczegółowe informacje na temat funkcji 
oscyloskopu. Dostęp do pomocy online uzyskuje się przyciskiem 
Help lub z menu Help. 

Poleceniach programowania Instrukcja programowania (na załączonym do przyrządu CD). 
Zawiera opis składni poleceń GPIB. 

Narzędziach analizy Instrukcja oprogramowania OpenChoice. Zawiera informacje 
dotyczące różnych narzędzi analizy dostępnych w przyrządzie. 

 

Oznaczenia użyte w instrukcji 
W niniejszej instrukcji użyte zostały poniższe ikony. 

 

Kolejność 
czynności 

Włączenie 
zasilania na 

płycie czołowej 

Podłączenie 
zasilania 

Sieć LAN PS2 SVGA USB 
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Podłączenie przyrządu 
  
 Rozpakuj przyrząd i sprawdź czy otrzymałeś wszystkie elementy wyszczególnione w liście standardowych 

akcesoriów.  Akcesoria zalecane, sondy, opcje przyrządu oraz modyfikacje są zestawione w pomocy online. 
Sprawdź aktualne informacje na internetowej stronie producenta www.tektronix.com.  

 
 

Akcesoria standardowe 
 

Akcesoria Numer części Tektronix 
Instrukcja użytkownika oscyloskopów serii DPO7000 020-2335-xx 

CD z aplikacją dla DPO7000 020-2693-xx 

CD do odtwarzania systemu operacyjnego 020-2659-xx 

CD z aplikacjami opcjonalnymi wraz z dokumentacją Zamawiane przez nazwę 

System pomocy online (element oprogramowania produktu) - 

Procedura weryfikacji parametrów (plik pdf na CD z aplikacją DPO7000) - 

Przewodnik programowania (pliki na CD z aplikacją DPO7000) - 

Certyfikat kalibracji NIST, Z540-1 i ISO9000 - 

Cztery sondy pasywne 10x, modele 500 MHz, tylko DPO7054 P6139A 

Mysz optyczna 119-7054-xx 

Pokrywa przednia 200-4963-xx 

Torba na akcesoria 016-1966-xx 

Wyposażenie do kalibracji sond wraz z instrukcją 067-0405-xx 

CD z programem Nero OEM 063-3781-xx 

Przewód zasilający Ameryka Północna (opcja A0) 161-0104-00 

 Europejski uniwersalny (opcja A1) 161-0104-06 

 Wielka Brytania (opcja A2) 161-0104-07 

 Australia (opcja A3) 161-0104-05 

 Szwajcaria (opcja A5) 161-0167-00 

 Japonia (opcja A6) 161-A005-00 

 Chiny (opcja A10) 161-0306-00 

 Indie (opcja A11) 161-0324-00 

 Bez przewodu zasilającego (opcja A99) - 
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Wymagania dotyczące użytkowania 
 
1. Położyć przyrząd na biurku i  

sprawdzić wymagane prześwity: 
 

� Góra: 0 mm 

� Lewy i prawy bok: 76 mm 

� Dół: 0mm postawiony 
      na stopkach 

� Tył: 0 mm od tylnych stopek 
 
2. Sprawdzić czy temperatura otoczenia  

zawiera się w przedziale 0 °C do +50 °C 
(+32 °F do +122 °F). 

 

 

 
 

OSTRZEŻENIE Aby mieć pewność prawidłowego chłodzenia, należy pozostawić wolną przestrzeń wokół boków i 
spodu przyrządu. 
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Włączanie przyrządu 
 Wymagania dotyczące zasilania 

Napięcie i częstotliwość źródła zasilania Pobór mocy 

100-240 VRMS ±10%, 50-60 Hz 
lub 115 VRMS ±10%, 400 Hz 

≤ 400 VA 
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Wyłączanie przyrządu 
 

 

 

 

Odłączanie zasilania 
 

 

 

 

 

 

Podłączenie do sieci 
 

 

 Przyrząd można podłączyć do sieci w celu 
drukowania, udostępniania plików czy 
dostępu do internetu. Aby skonfigurować 
ustawienia sieciowe przyrządu skontaktuj 
się z administratorem sieci oraz użyj 
standardowych narzędzi konfiguracyjnych 
Windows. 

 

 

 

 

 

 

 

 



Podłączenie przyrządu 

DPO7000 Instrukcja użytkownika 5

Dodawanie drugiego monitora 
 Przyrządu można używać podczas korzystania z systemu Windows i zainstalowanych aplikacji na monitorze 

zewnętrznym. Postępuj zgodnie z poniższą procedurą aby ustawić konfigurację dwumonitorową.  

 

1. Wyłącz zasilanie. 

2. Podłącz drugi monitor. 

 

 

 

 

3. Podłącz klawiaturę. 

4. Podłącz mysz. 

 

 

5. Włącz zasilanie przyrządu. 

6. Włącz zasilanie monitora. 
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7. Wciśnij prawy przycisk myszy na panelu 
Windows i wybierz Properties. 

 

 

 

 

8. Wybierz zakładkę Settings. Kliknij 
szarawą ikonę zewnętrznego monitora 
(2) i przeciągnij ją na lewą stronę 
monitora 1. 

9. Wybierz Yes jeśli pojawi się zapytanie o 
włączenie nowego monitora. 

10. Wybierz Apply. 

 

 

 

 

11. Kliknij Yes aby ponownie uruchomić 
przyrząd. 
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Podstawy obsługi 
 
Panel przedni 

1. Napęd DVD/CD-RW 

2. Nastawy panelu przedniego 

3. port USB 

4. Zacisk masy 

5. Wyjście regenerowanego zegara, (DPO7254) 

6. Wyjście regenerowanych danych, (DPO7254) 

7. Wyjście kompensacji sondy 

8. Wyjście kalibracji sondy 

9. Wejścia kanałów 1-4 

10. Pomocnicze wejście wyzwalania 
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Panele boczne i tylny 
 

1. Porty USB 

2. Port Video do podłączenia  

 zewnętrznego monitora 

3. Złącze mikrofonowe 

4. Wyjście audio Line Out  

5. Port Video (zewnętrzny monitor 

 XGA tylko dla oscyloskopu) 

6. Podłączenie drukarki 

7. Złącze Line In 

8. Złącze RJ-45 do połączenia z 

Siecią 

9. Port równoległy Centronics 

10. Port szeregowy COM1 

11.  Złącze myszy PS-2 

12.  Złącze PS-2 klawiatury 

13. Złącze TekLink do przyszłych zastosowań 

14. Wyjmowalny napęd dysku twardego 

15. Port GPIB 

16. Wyjście pomocnicze 

17. Wyjście kanału 3 

18. Wejście zewnętrznego odniesienia 
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Interfejs i ekran 
Tryb paska menu umożliwia dostęp do nastaw regulujących wszystkie funkcje przyrządu. Tryb paska narzędzi 
zapewnia dostęp do funkcji najczęściej wykorzystywanych. 

1. Pasek menu: dostęp do danych I/O,
drukowania, pomocy online oraz
funkcji przyrządu 

2. Przyciski/menu: kliknij aby przełą-
czyć pomiędzy trybem paska menu
a paska narzędzi  

3. Odczyt pokrętła wielofunkcyj-
nego: Reguluje i wyświetla para-
metry kontrolowane przez pokrętło
wielofunkcyjne 

4. Ekran: Wyświetla aktualne przebiegi
odniesienia i matematyczne wraz z
kursorami 

5. Uchwyt przebiegu: Kliknij i przecią-
gnij aby zmienić pionowe położenie
przebiegu. Kliknij uchwyt i zmień
pozycję i skalę pionową przy po-
mocy pokrętła wielofunkcyjnego 

6. Status nastaw: Szybki podgląd na-
staw pionowych, skali, offsetu i pa-
rametrów 

7. Odczyt: W tym obszarze wyświe-
tlane są odczyty kursorów i pomia-
rów. Pomiary wybierane są z paska
menu lub narzędzi. Jeśli wyświe-
tlane jest okno nastaw, niektóre
odczyty przesuwane są w obszar
siatki 

OSTRZEŻENIE. Pomiary automatyczne
związane z amplitudą przebiegów ob-
ciętych w osi pionowej dają niedokładny
wynik. Obcięcie jest też powodem nie-
dokładnej amplitudy przebiegów zapisy-
wanych lub wysyłanych do innych pro-
gramów. Jeśli obcięty jest przebieg ma-
tematyczny nie ma to wpływu na jego
amplitudę 

8. Status: Wyświetla status, tryb oraz
ilość akwizycji; status wyzwalania,
datę, czas i szybki podgląd nastaw
poziomych i długości rekordu 
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1. Przyciski/menu: kliknij aby
przełączyć pomiędzy trybem paska
menu a narzędzi 

2. Przeciągnij kursory aby zmierzyć
przebiegi na ekranie 

3. Przeciągnij ikonę aby zmienić
pozycje przebiegu 

4. Kliknij ikonę aby przydzielić pokrętłu
wielofunkcyjnemu możliwość
zmiany skali i pozycji pionowej 

5. Przeciągnij ikonę aby zmienić
poziom wyzwalania 
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Panel elementów regulacyjnych 

1. Wciśnij aby automatycznie ustawić
pionowe i poziome nastawy oraz
wyzwalanie dla wybranego kanału 

2. Naciśnij aby przywrócić nastawy
domyślne 

3. Naciśnij aby wykonać kopię lub zapisać
obraz z ekranu 

4. Naciśnij aby włączyć MultiView Zoom i
dodać powiększoną siatkę do ekranu 

5. Poziome skalowanie, pozycja, opóźnienie
i długość rekordu (rozdzielczość)
wszystkich przebiegów 

6. Uruchomienie i zatrzymanie akwizycji,
start pojedynczej sekwencji akwizycji,
kasowanie danych oraz włączenie trybu
FastAcquisition 

7. Nastawy parametrów wyzwalania. Wciśnij
Advanced aby wyświetlić dodatkowe
funkcje wyzwalania. Status wyzwalania
sygnalizują lampki Arm, Ready i Trig’D 

8. Pokręć aby regulować intensywność
przebiegu 

9. Pokręć aby regulować parametry
określone za pomocą interfejsu
ekranowego. Wciśnij aby przełączyć
pomiędzy regulacją normalną a dokładną 

10. Wciśnij aby włączyć lub wyłączyć kursory 

11. Wciśnij aby włączyć lub wyłączyć ekran
dotykowy 

12. Włącz lub wyłącz wyświetlanie przebiegu.
Pionowe skalowanie, pozycjonowanie
oraz offset przebiegu. Przełączanie
pomiędzy pozycją a offsetem 
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Dostęp do pomocy online 
Bardziej szczegółowe informacje dotyczące funkcji przyrządu dostępne są w pomocy online. 

Aby uzyskać dostęp do pomocy kontekstowej
aktywnego okna wybierz Help>Help on
Window... lub naciśnij F1. 

 

 

 

 

 

1. Aby uzyskać dostęp do dowolnego
tematu pomocy wybierz Help>Contents
and Index... 

2. Użyj zakładki Contents, Index, Serch lub
Favorites aby wybrać temat pomocy a
następnie kliknij Display. 

 

 

 

Aby poruszać się w systemie pomocy
możesz: 

� Kliknąć przycisk w oknie pomocy aby
nawigować pomiędzy opisem i
wybranym zagadnieniem 

� Kliknąć przycisk Minimize w oknie
pomocy aby odsunąć pomoc i móc
używać przyrządu 

� Kliknąć Alt i Tab aby ponownie
zobaczyć pomoc na ostatnio zadany
temat 
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Dostęp do okien nastaw i menu 
Wykonanie następujących czynności umożliwia dostęp do okienek nastaw i menu: 

� Kliknij menu a następnie wybierz
polecenie 

 

 

 

 

 

� Dla uzyskania skróconego menu kliknij
prawym przyciskiem gdziekolwiek na
ekranie. Skrócone menu jest kontekstowe
i zmienia się w zależności od obiektu na
którym nastąpiło kliknięcie. Kilka
przykładów widocznych jest na rysunku
po prawej stronie 

 

 

 

 

 

 

 

 

� W trybie paska narzędzi kliknij przycisk w
celu szybkiego dostępu do okienka
nastaw (patrz str. 9) 
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Sprawdzenie przyrządu 
  

Aby sprawdzić funkcjonalność przyrządu użyj poniższej procedury. 

 

Weryfikacja przebiegu diagnostyki wewnętrznej 

1. Włącz przyrząd 

 

 

 

 

 

 

 

 

 

2. Wybierz Instrument Diagnostics... 
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3. Kliknij Run. Rezultaty testu pojawią się w
oknie diagnostycznym. 

4. Zweryfikuj czy wszystkie testy przeszły
pozytywnie. W przypadku błędu
diagnostyki, skontaktuj się z lokalnym
serwisem Tektronix. 

 

  

 

 

Kompensacja ścieżki sygnałowej 
 Postępuj zgodnie z tą procedurą jeśli temperatura zmieniła się więcej niż 5 °C (9 °F) od ostatniej kompensacji toru 

sygnałowego. Wykonuj kompensację ścieżki sygnału raz w tygodniu. Zakończona niepowodzeniem może 
oznaczać, że przyrząd nie zapewnia spełnienia parametrów na gwarantowanym poziomie. 

1. Warunki wstępne: przyrząd włączony
przez co najmniej 20 minut i odłączone
wszystkie sygnały wejściowe 

 

 

 

 

 

 

 

2. Wybierz Instrument Calibration. 
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3. Kiedy status zmieni się na Temp, kliknij
Calibrate aby rozpocząć kalibrację. Może
ona trwać 10 do 15 minut. 

 

 

 

 

 

 

4. Jeśli zakończyła się ona niepowodzeniem
wykonaj kalibrację ponownie lub sprawdź
przyrząd w autoryzowanym serwisie. 
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Akwizycja 
  

Sekcja ta opisuje zasadę działania i sposób użycia systemu akwizycji. 
 

Nastawy wejściowe 
Aby ustawić przyrząd do rejestrowania sygnału należy posłużyć się przyciskami panelu przedniego. 

  
1. Podłącz sondę do źródła sygnału 

 

 

 

 

 

 

 

 

2. Wybierz kanał wejściowy poprzez
wciśnięcie przycisku na panelu przednim,
przełączając pomiędzy wyłączeniem a
włączeniem. 
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3. Wciśnij Autoset. 

4. Wyreguluj pozycję pionową, skalę i offset
używając pokręteł przedniego panelu
(wciśnij pokrętło aby przełączyć pomiędzy
pozycją a offsetem) 

 

 

 

 

 

 

5. Wyreguluj pozycjonowanie poziome i
skalę używając pokręteł panelu
przedniego. Pozycja pozioma określa
ilość próbek obszaru pre- i post triggera. 

 

 

 

 

 

 

 

Użycie nastaw domyślnych 
1. W celu szybkiego powrotu do nastaw 

fabrycznych wciśnij DEFAULT SETUP. 
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Użycie funkcji Autoset 
 Użyj funkcji Autoset aby szybko i automatycznie ustawić nastawy przyrządu (akwizycja, wyzwalanie, nastawy 

poziome i pionowe) w oparciu o właściwości sygnału wejściowego. Autoset dokonuje takich regulacji aby 
wyświetlane były dwa lub trzy cykle przebiegu z poziomem wyzwalania blisko średniego poziomu sygnału. 

  

1. Dołącz sondę i wybierz kanał 
wejściowy. (patrz strona 17, 
Nastawy wejściowe.) 

2. Wciśnij przycisk AUTOSET aby 
wykonać funkcję Autoset. 

 

 

 

 

3. Kliknij Undo jeśli chcesz cofnąć 
ostatni Autoset. Parametry nie 
zmieniane przez Autoset pozostają 
bez zmian. 

 

 

 

 
 

 

Szybkie podpowiedzi 
� Aby odpowiednio wypozycjonować przebieg, Autoset może zmienić pozycję pionową. Autoset ustawia offset 

zawsze na 0V. 

� Użycie funkcji Autoset, kiedy wyświetlanych jest kilka przebiegów, przyrząd wybiera kanał o najniższym 
numerze i względem niego ustawia skalę pozioma oraz wyzwalania. Skala pionowa każdego kanału może być 
ustawiana indywidualnie.  

� Użycie funkcji Autoset kiedy żaden przebieg nie jest wyświetlany, spowoduje włączenie kanału 1. 

� Zamknięcie okna Undo Autoset jest możliwe poprzez klikniecie symbolu X. Po jego zamknięciu wciąć istnieje 
możliwość cofnięcia ostatnich ustawień automatycznych poprzez wybranie komendy Undo Last Autoset w 
menu Edit. 

� Poprzez zmianę preferencji użytkownika w menu Utilities można zatrzymać automatyczne otwieranie okna 
cofnięcia ostatnich nastaw automatycznych. Undo Autoset  

 

Kompensacja sondy, kalibracja, wyrównanie opóźnień kanałów 
Aby zoptymalizować dokładność pomiarów, należy wykonać poniższe procedury, opisane w systemie pomocy 
online: 

� Kompensacja sond pasywnych 

� Kompensacja toru sygnałowego przyrządu 
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� Kalibracja sond aktywnych 

� Wyrównanie opóźnień czasowych torów pomiarowych 

 

Sposób gromadzenia danych 

Proces akwizycji  
Zanim sygnał będzie mógł być wyświetlony, musi przejść przez kanał wejściowy , gdzie jest skalowany i 
zamieniany na postać cyfrową. Każdy kanał posiada własny wzmacniacz i przetwornik analogowo cyfrowy. Każdy 
z kanałów tworzy strumień danych cyfrowych, z którego przyrząd wybiera rekord przebiegu. 

Proces próbkowania 
Akwizycja jest procesem próbkowania sygnału 
analogowego, konwersji do postaci cyfrowej i 
złożenia danych w rekord przebiegu, który jest 
zapamiętywany w pamięci akwizycji 

 

 

 

 

Sygnał wejściowy     Punkty próbkowania     Wartości cyfrowe 

Próbkowanie w czasie rzeczywistym 
Podczas próbkowania w czasie rzeczywistym, 
oscyloskop rejestruje wszystkie próbki w 
jednym wyzwoleniu. Próbkowanie to jest 
używane podczas obserwacji zdarzeń 
niepowtarzalnych lub zboczy sygnału 

  

   

 

Próbkowanie w czasie rzeczywistym 
z interpolacją 

Podczas próbkowania w czasie rzeczywistym z 
interpolacją przyrząd rejestruje wszystkie 
próbki w jednym wyzwoleniu. Jeśli jednak nie 
może zgromadzić wystarczającej liczby próbek 
przy maksymalnej szybkości próbkowania, 
wówczas interpoluje brakujące dane. Tryb ten 
używany jest do obserwacji zdarzeń 
niepowtarzalnych, zboczy sygnału lub wolnej 
rejestracji. 

  

 

 

 

 

 

 

 

 

 

Punkty rekordu 
 
 
Szybkość próbkowania 
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Próbkowanie w czasie ekwiwalentnym 
Przyrząd używa próbkowania w czasie 
ekwiwalentnym, aby zwiększyć szybkość 
próbkowania poza maksymalną wartość dla 
czasu rzeczywistego. Tryb ten jest używany tylko 
wówczas jeśli wybrano Equivalent Time a 
podstawa czasu jest zbyt krótka aby utworzyć 
rekord w pojedynczym wyzwoleniu. 

Przyrząd wykonuje wiele rejestracji sygnału 
powtarzalnego, sukcesywnie uzyskując 
wymaganą ilość próbek. Z tego powodu tryb ten 
jest używany tylko dla sygnałów powtarzalnych 

  

 

 

 

Rekord akwizycji 
Przyrząd buduje rekord akwizycji, określony  
następującymi parametrami: 

� Interwał próbkowania: czas pomiędzy kolejnymi 
próbkami 

� Długość rekordu: ilość próbek wymagana do 
wypełnienia rekordu 

� Punkt wyzwolenia: zerowy punkt odniesienia 
osi czasu w rekordzie 

� Pozycja pozioma: kiedy opóźnienie poziome 
jest wyłączone, pozycja pozioma określa 
procent rekordu, pomiędzy 0 a 99%. Punkt 
wyzwolenia i odniesienie poziome są tym 
samym czasem w rekordzie. Dla przykładu, 
jeśli pozycja pozioma wynosi 50%, punkt 
wyzwolenia jest środkiem rekordu. Jeśli 
opóźnienie poziome jest włączone, jest ono 
czasem pomiędzy punktem wyzwolenia a 
pozycja poziomą.  

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Punkty rekordu 
 
 

Pierwszy cykl rejestracji 
 
 
Drugi cykl rejestracji 
 
 
Trzeci cykl rejestracji 
 
 
Czwarty cykl rejestracji 

Punkt wyzwolenia 

Opóźnienie poziome 
Pozycja pozioma 

Poziome okno 
akwizycji 

Interwał próbkowania 

Poziomy punkt 
odniesienia 

Pierwsza próbka w 
rekordzie 
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Interpolacja 
Jeśli nie cały rekord został wypełniony próbkami, przyrząd ma możliwość interpolacji brakujących danych. 
Interpolacja liniowa oblicza brakujące punkty w rekordzie łącząc odcinkami prostymi zgromadzone punkty. 

Interpolacja sin(x)/x oblicza punkty w rekordzie używając dopasowanej krzywej pomiędzy próbkami. Interpolacja 
sin(x)/x jest domyślnym trybem interpolacji ponieważ wymaga zgromadzenia mniej próbek niż interpolacja liniowa 
dla dokładnego odwzorowania przebiegu. 

Szybka podpowiedź 
■ Aby wyróżnić próbki zgromadzone w czasie rzeczywistym na tle danych interpolowanych należy wybrać tryb      

Intesified Samples. 

 

Jak działają różne tryby akwizycji 
Sample, rejestrowana jest pierwsza próbka w 
każdym interwale akwizycji. Jest to domyślny tryb 
próbkowania 

 

Peak Detect (detekcja pików), rejestruje próbki 
o najwyższej i najniższej wartości zawarte w 
dwóch kolejnych interwałach akwizycji. Tryb ten 
pracuje wyłącznie w czasie rzeczywistym bez 
interpolacji i jest przydatny do wykrywania 
zakłóceń szpilkowych 

 

 

Hi Res (wysoka rozdzielczość), oblicza średni 
poziom próbki w każdym interwale akwizycji. Tryb 
ten zapewnia większą rozdzielczość ale węższe 
pasmo.  

Envelope (obwiednia), tryb ten rejestruje 
najwyższe i najniższe wartości w wielu cyklach 
akwizycji. Tryb obwiedni używa detekcji pików w 
każdym cyklu akwizycji.  

 

Average (uśrednianie), oblicza uśrednione 
wartości dla każdego punktu rekordu w wielu 
cyklach akwizycji. Tryb uśredniania redukuje 
szum. 

 

Waveform Database, jest to trójwymiarowa 
akumulacja przebiegu źródłowego w kilku cyklach 
akwizycji. Poza informacją o czasie i amplitudzie, 
tryb ten zlicza liczbę wystąpień każdego 
zarejestrowanego punktu tworzącego przebieg. 
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Zmiana trybów akwizycji 
Aby zmienić tryb akwizycji należy: 

1. Wybierz Horiz/Acq>Acquisition Mode. 

2. Aby wybrać tryb akwizycji należy 
wykonać jedno z poniższych 

■   Wybrać tryb akwizycji bezpośrednio z 
menu. 

■ Kliknąć Mode..., i wybrać tryb  
akwizycji. 

 

 

3. Dla trybów akwizycji uśredniania lub 
obwiedni, kliknąć kontrolkę # of Wfms i 
ustalić liczbę przebiegów za pomocą 
wielofunkcyjnego pokrętła. Dla trybu WfmDB 
kliknąć kontrolkę Samples i ustawić liczbę 
próbek pokrętłem wielofunkcyjnym. 

 

 

 

Szybka podpowiedź 
■ Aby ustalić liczbę próbek lub przebiegów można kliknąć ikonę klawiatury. 
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Uruchomienie i zatrzymanie akwizycji 
Po wybraniu kanałów, których sygnały maja być rejestrowane, należy wykonać czynności: 

1. Wcisnąć przycisk RUN/STOP na 
przednim panelu uruchamiając 
proces akwizycji 

2. Aby zatrzymać akwizycje wcisnąć 
ponownie przycisk RUN/STOP 

3. Aby uruchomić jednorazową 
akwizycję wcisnąć przycisk Single. 

 

 

 

Wykorzystanie FastAcq 
Tryb szybkiej akwizycji redukuje czas martwy pomiędzy rejestracjami przebiegu, umożliwiając rejestrację i 
wyświetlenie zakłóceń szpilkowych lub impulsów. Tryb szybkiej akwizycji może także wyświetlać zjawiska 
występujące w przebiegu z intensywnością odzwierciedlającą częstotliwość ich wystąpienia. 

 

Należy wykonać następującą procedurę: 

1.  Wcisnąć FastAcq 

 

2. Odszukać przypadkowe zakłócenia 
szpilkowe. 

Jeśli anomalie sygnału zostały 
zidentyfikowane, można tak ustawić 
system wyzwalania aby umożliwiał 
wyłapywanie. 
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Wykorzystanie trybu przewijania 
Dla przebiegów o małej częstotliwości, tryb przewijania umożliwia obserwacje przebiegu w podobny sposób jak w 
przypadku taśmy rejestratora. Tryb przewijania wyświetla zarejestrowane dane bez czekania na skompletowanie 
rekordu przebiegu. 

1.  Wybrać Horiz/Acq > 
Horizontal/Acquisition Setup... 

 

2. Jeśli nie jest to wybrane, kliknąć 
zakładkę Acquisition. Kliknąć Auto 
aby włączyć tryb przewijania. 

UWAGA. Tryb przewijania wymaga 
akwizycji typu Sample, Peak Detect 
lub HiRes  

3. Aby zatrzymać tryb przewijania 
akwizycji należy: 

       ■  Jeśli nie jest włączona 
jednorazowa akwizycja wcisnąć 
RUN/STOP 

       ■  Jeśli jest włączona jednokrotna 
akwizycja, tryb przewijania 
zostanie zatrzymany 
automatycznie, po zapełnieniu 
rekordu akwizycji. 

 

 

Szybka podpowiedź 
■ Przełączenie trybu akwizycji na uśrednianie, obwiednię lub WfmDB wyłączy tez tryb przewijania. 

■ Dla podstaw czasu 50 ms/dz lub szybszych, tryb przewijania jest wyłączony. 
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Wyzwalanie Pinpoint 
System wyzwalania Pinpoint zapewnia zaawansowane tryby wyzwalania w obu obwodach wyzwalania A i B, 
kasowanie sekwencji wyzwalającej w przypadku braku wystąpienia zdarzenia B po określonym czasie lub 
określonej liczbie zdarzeń. Wyzwalanie Pinpoint zapewnia wychwycenie zjawisk bazując na najbardziej złożonych 
zdarzeniach wyzwalających lub sekwencji zdarzeń. 

Sekcja ta wyjaśnia zasadę i sposób użycia systemu wyzwalania. 

 

Zasada wyzwalania 

Zdarzenie wyzwalające 
Zdarzenie wyzwalające ustanawia zerowy punkt na osi czasu w rekordzie akwizycji. Wszystkie dane w rekordzie 
umieszczone są w czasie z uwzględnieniem tego punktu. Przyrząd ciągle rejestruje i gromadzi dane w obszarze 
pretriggera. Kiedy następuje zdarzenie wyzwalające, oscyloskop rozpoczyna pobieranie próbek do obszaru 
posttriggera (wyświetlane po lub po prawej stronie zdarzenia wyzwalającego). Od momentu rozpoznania 
wyzwolenia, przyrząd ignoruje wszystkie pozostałe wyzwolenia aż do momentu zakończenia akwizycji i upływu 
czasu podtrzymania. 

 

Tryby wyzwalania 
Tryby wyzwalania określają jak przyrząd będzie się zachowywał przy nieobecności zdarzeń wyzwalających: 

■  Tryb Normal umożliwia rejestrację danych tylko po wyzwoleniu. Jeśli brak jest zdarzeń wyzwalających, na 
ekranie   pozostanie przebieg ostatnio zarejestrowany. 

■  W trybie Auto przyrząd rejestruje dane nawet jeśli wyzwolenie nie następuje. Tryb Auto używa timera, który 
startuje po wystąpieniu zdarzenia wyzwalającego. Jeśli przed upływem czasu timera nie zostanie rozpoznane 
zdarzenie wyzwalające to oscyloskop sam wygeneruje wyzwolenie. Czas oczekiwania na zdarzenie 
wyzwalające zależy od ustawień podstawy czasu. 

Kiedy tryb Auto generuje wyzwolenie przy nieobecności zdarzenia wyzwalającego, przebieg na ekranie nie jest 
synchronizowany. Dlatego przebieg może przemieszczać się na ekranie. Jeśli wystąpi zdarzenie wyzwalające 
obraz będzie stabilny. 

Możliwe jest także wymuszenie wyzwolenia zboczem wyzwalającym poprzez naciśnięcie przycisku Force Trigger 
w okienku kontroli ustawień wyzwalania. 

Tryb wyzwalania wybiera się w menu Trig>Mode. Więcej informacji zawartych jest w systemie pomocy online. 

 

Czas podtrzymania wyzwalania 
Czas podtrzymania wyzwalania może pomóc ustabilizować wyzwalania. Kiedy przyrząd rozpozna zdarzenie 
wyzwalające, wyłącza system wyzwalania do momentu zakończenia akwizycji. Dodatkowo system wyzwalania 
pozostaje wyłączony podczas czasu podtrzymania po każdej akwizycji. Regulacja czasu podtrzymania pozwala 
uzyskać stabilne wyzwalanie w przypadku gdy przyrząd jest wyzwalany niepożądanymi zdarzeniami. 

Czas podtrzymania ustawia się w menu Trig>Holdoff. 
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Sprzężenie wyzwalania 
Sprzężenie wyzwalania określa jaka część sygnału przepuszczana jest do obwodu wyzwalania. Wyzwalanie 
zboczem może używać wszystkich dostępnych trybów sprzężenia: AC, DC, Low Frequency Rejection, High 
Frequency Rejection. Wszystkie pozostałe tryby wyzwalania są sprzężone wyłącznie stałoprądowo (DC). 

Sprzężenie wyzwalania ustawia się w menu Trig>A Event (Main). Więcej informacji znajduje się w systemie 
pomocy online przyrządu. 

 

Pozycjonowanie poziome 

Pozycja pozioma określa położenie punktu wyzwolenia w rekordzie. Pozwala to określić jak dużo przyrząd 
rejestruje przed i po wyzwoleniu. Część rekordu przed wyzwoleniem jest pretriggerem. Część występująca po 
wyzwoleniu jest obszarem posttriggera.  

Dane pretriggera mogą być znaczące podczas wyszukiwania błędów. Dla przykładu, jeżeli poszukiwana jest 
przyczyna niepożądanych zakłóceń szpilkowych w obwodzie, można wyzwolić na tym zakłóceniu i zwiększyć 
obszar pretriggera aby zarejestrować dane przed zakłóceniem. Poprzez analizę tego co następuje przed 
zakłóceniem, możliwe jest odkrycie informacji pozwalającej ustalić źródło zakłócenia. Alternatywnie, jeżeli istnieje 
potrzeba zobaczenia co się dzieje w systemie w rezultacie zdarzenie wyzwalającego, należy odpowiednio 
zwiększyć obszar posttriggera, rejestrując dane po wyzwoleniu. 

 

Zbocze i poziom 
Określenie zbocza pozwala ustalić czy przyrząd będzie wyzwalany zboczem narastającym czy opadającym. 
Regulacja poziomu określa położenie punktu wyzwolenia na zboczu. 

 

Opóźniony system wyzwalania 
Wyzwalanie może następować poprzez główny system wyzwalania A lub połączenie systemu A i opóźnionego B w 
celu wyzwalania sekwencją. Przy wyzwalaniu sekwencyjnym zdarzenie wyzwalające A uzbraja system 
wyzwalania, a zdarzenie wyzwalające B wyzwala przyrząd, jeśli warunki wyzwalania B są spełnione. Wyzwalanie A 
i B mogą mieć(i najczęściej mają) oddzielne źródła. Warunek wyzwolenia B może bazować na opóźnieniu czasem 
lub określoną liczbą zdarzeń. (patrz strona 31, Wykorzystanie wyzwalania A(główne) i B(opóźnione)). 
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Wybór rodzaju wyzwalania 
Przyrząd umożliwia modyfikację podstawowych parametrów wyzwalania z panelu przedniego lub ustalić więcej 
zaawansowanych wyzwoleń w oknie ustawień Trigger Setup. 

1.  Wciśnij EDGE. 

2. Ustaw źródło, zbocze i tryb. Aby ustalić 
sprzężenie uzyj menu Trigd> Edge 
Setup. 

3. Aby wybrać jeden z pozostałych trybów 
wyzwalania należy wykonać jedną z 
czynności: 

   ■  Wcisnąć ADVANCED 

      ■  Wybrać rodzaj wyzwalania  
bezpośrednio z menu Trig 

 

 

4. Dokończyć ustawienia wyzwalania 
korzystając z regulacji wyświetlanych 
dla rodzaju wyzwalania. Wyświetlane 
regulacje zależą od wybranego rodzaju 
wyzwalania 
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Wybór wyzwalania Pinpoint 

Rodzaj wyzwalania  Warunek wyzwalania 

Edge  
Wyzwolenie na narastającym lub opadającym zboczu. Wybór sprzężenia 
spośród DC, AC, LF Reject, HF Reject i Noise Reject 

Glitch  

Wyzwolenie na impulsie węższym (lub szerszym) niż określona szerokość 
lub opuszczanie zakłóceń szpilkowych węższych lub szerszych niż zadana 
szerokość 

Width  
Wyzwolenie impulsami, które mieszczą się lub nie w określonym 
przedziale czasowym. Wyzwolenie impulsem dodatnim lub ujemnym. 

Runt 
 

Wyzwolenie impulsem o amplitudzie przekraczającej jeden poziom ale nie 
przekraczającej drugiego poziomu. Wykrywane są impulsy dodatnie lub 
ujemne lub tylko szersze od zadanego czasu. Impulsy mogą być także 
kwalifikowane jako stany logiczne pozostałych kanałów. 

Window 

 

Wyzwolenie gdy sygnał wejściowy przekracza górny lub dolny próg. 
Wyzwolenie sygnałem który mieści się wewnątrz lub przekracza zadane 
okno. Określić można czas używając nastaw Trigger When Wider lub 
stanem logicznym pozostałych kanałów używając opcji Trigger when 
Logic. 

Timeout  Wyzwolenie gdy wykryto impuls w zadanym przedziale czasu. 

Transition 
  

Wyzwolenie zboczem impulsu narastającym wolniej lub szybciej niż 
określony czas. Impuls może być dodatni lub ujemny. 

Serial 
  

Wyzwolenie 64-bitowymwzorcem szeregowym dla danych do 1.25 Gb/s 
Opcja zawiera regenerację sygnału zegara. 

Pattern 
  

Wyzwolenie gdy wejście logiczne spowoduje stan wybranej funkcji prawda 
lub fałsz 

State 
  

Wyzwolenie gdy wszystkie logiczne wejścia wybranej funkcji spowodują 
prawdę lub fałsz podczas zmiany sygnału zegarowego. 

Setup/Hold   
Wyzwolenie, gdy zmienia stan wewnątrz czasów setup and hold w 
odniesieniu do sygnału zegara. 

Comm  
Wyzwalani w połączeniu z maską komunikacyjną określonego standardu. 
Opcja ta zawiera regeneracje sygnału zegara 

Video  
Wyzwolenie określonym polem lub linia sygnału wizyjnego. Obsługiwane 
są tylko sygnały kompozytowe. 

SPI  
Wyzwalanie sygnałami interfejsu SPI. 

I2C  
Wyzwalanie sygnałami I2C: start, stop, powtórny start, brak potwierdzenia, 
adres, dana oraz adres i dana. 

RS-232  
Wyzwalanie sygnałami RS-232. 

CAN  
Wyzwolenie sygnałami magistrali CAN. 
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Sprawdzanie statusu wyzwalania 
Status wyzwalani można sprawdzić na podstawie lampek panelu przedniego lub poprzez odczyt na ekranie. 

Aby sprawdzić status wyzwalania sprawdź 
lampki na przedni panelu ARM, READY, 
TRIG’D 

■   lampka TRIG’D oznacza że oscyloskop 
rozpoznał zdarzenie wyzwalające i 
wypełnia próbkami obszar posttriggera 

■ READY oznacza, że przyrząd może 
przyjąć i czeka na zdarzenie 
wyzwalające. Gromadzone są dane w 
obszarze pretriggera. 

■ ARM oznacza zapełnienie obszaru 
pretriggera 

■ oba TRIG’D oraz READY oznaczają 
rozpoznanie ważnego zdarzenia A i 
oczekiwanie na wyzwolenie opóźnione 
Kiedy zostanie ono rozpoznane, obszar 
postriggera opóźnionego wyzwolenia 
zostanie wypełniony próbkami. 

■ wyłączenie ARM, TRIG’D i READY 
oznacza zatrzymanie akwizycji. 

 

 

 

 

Aby szybko określić nastawy kluczowych 
parametrów wyzwalania, należy sprawdzić 
odczyt wyzwalania u dołu ekranu. Odczyt 
jest różny dla wyzwalania zboczem i 
zaawansowanego: 

1. źródło wyzwalania A = Ch1 

2. Zbocze wyzwalające = narastające 

3. poziom wyzwalania 

4. podstawa czasu 
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Wykorzystanie wyzwalania A (główne) i B (opóźnione) 
Możliwe jest wykorzystanie głównego wyzwalania A dla prostych sygnałów lub w połączeniu z wyzwalaniem 
opóźniony B do wychwycenia sygnałów złożonych. Po wystąpieniu zdarzenia A, system wyzwalania oczekuje na 
zdarzenie B, zanim nastąpi wyzwolenie i wyświetlenie przebiegu. 

Wyzwalanie główne A 

1. Wybierz Trig > A Event (Main) Trigger 
Setup.… 

 
2.  Ustaw rodzaj i źródło wyzwalania A w 

zakładce A Event. 

 

 

 

 

 

 

 

 

Wyzwalanie opóźnione B 

 
 

3. Wybierz funkcję w zakładce A →B Seq. 

4. Ustaw czas opóźnienia wyzwalania B lub 
liczbę zdarzeń. 
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5. Ustawić elementy wyzwalania B w zakładce B 
Event. 

 

 
6. Ustaw tryb wyzwalania Normal i czas 
podtrzymania Holdoff w zakładce Mode. 

 

 

 

 

 

 

 

Wyzwolenie zdarzeniem B 

 
 

 

Wyzwolenie A uzbraja przyrząd. Akwizycja 
posttriggera rozpoczyna się n-tym zdarzeniem B. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Punkt wyzwalania A 

Źródło wyzwalania A 

Źródło wyzwalania B 

Punkt wyzwolenia B 

Zapisany rekord 
przebiegu 

Oczekiwanie na n-te zdarzenie (gdzie n=5) 
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Wyzwalanie B po czasie opóźnienia 
Wyzwolenie A uzbraja przyrząd. 

Zapis obszaru posttriggera rozpoczyna się 
pierwszym zboczem B, po upływie czasu 
opóźnienia. 

 

 
Kasowanie wyzwalania 
Można określić warunek kasowania 
systemu wyzwalania, występującego przed 
zdarzeniem B,. Kiedy wystąpi zdarzenie 
kasujące, system wyzwalania zatrzymuje 
się czekając na zdarzenie B i powraca do 
oczekiwania na zdarzenie A. 

 

 
 

Szybka podpowiedź 

■ Czas opóźnienia wyzwalania B i czas opóźnienia w osi poziomej są niezależnymi funkcjami. Kiedy określi się 
warunki wyzwalania używając tylko samego wyzwalania A lub łącznie A i B, można także wykorzystać 
opóźnienie poziome w celu dodatkowego opóźnienia akwizycji. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Źródło wyzwalania A 

Źródło wyzwalania B 

Punkt wyzwalania A 

Punkt wyzwalania B Opóźniony 
czas 

wyzwolenia 

Kasowanie 

Zdarzenie B 
wyzwalające oscyloskop 

Kasowanie  

Zdarzenie B 

Minimum 100 nanosekund 

Pierwsze zdarzenie 
B po kasowaniu 
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Wysyłanie e-maili po wyzwoleniu 
Przed wykonaniem poniższej procedury należy skonfigurować e-mail. 

1. Wybierz Trig > A Event (Main) Trigger 
Setup.… 

2. Wybierz zakładkę Mode. 

3. Na „E-mail on Trigger” kliknij On a 
następnie Setup. (Zobacz str 93, 
ustawienia E-mail on Event). 

 

 

Wykorzystanie opóźnienia  

 
Aby zarejestrować szczegóły przebiegu w 
rejonie nie związanym  z położeniem 
wyzwolenia, należy wykorzystać opóźnienie 
o wymagany czas. 

 
 

1. Wciśnij DELAY. 

2. Ustal czas opóźnienia za pomocą 
pokrętła położenia poziomego 
POSITION lub wpisz wartość 
opóźnienia w oknie regulacji. 

3. Ustal skalę poziomą SCALE aby 
zarejestrować żądany fragment 
przebiegu. 

 

 

 

 

 

 

 

 

 

Czas opóźnienia 

Zarejestrowany 
przebieg 

Punkt wyzwolenia 
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Szybka podpowiedź 
■ Aby powiększyć zarejestrowany opóźniony odcinek, należy użyć łącznie regulacji opóźnienia i MultiView Zoom 

■ Aby porównać szczegóły przebiegu blisko punktu wyzwolenia i wokół czasu opóźnienia należy przełączać 
opóźnienia poziome Horizontal Delaj pomiędzy on i off. 
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Wyświetlanie przebiegu 
Sekcja ta opisuje zasadę i procedury wyświetlania przebiegu. Szczegółowe informacje są dostępne w systemie 
pomocy online. 

 

Ustawienie stylu wyświetlania 

W celu ustawienia stylu wyświetlania 
należy wybrać Display > Display Style i 
wybrać jeden z następujących stylów: 

 

Wyświetla przebieg z 
liniami kreślonymi 
pomiędzy punktami 
rekordu. 

 

Wyświetla punkty z 
rekordu przebiegu jako 
kropki na ekranie. 

 

Wyświetla aktualne 
próbki. Punkty 
interpolowane nie są 
wyświetlane 
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Ustawienia poświaty ekranu 
Wybierz Display > Display Persistance I 
następnie wybierz rodzaj poświaty 

■ Przy braku poświaty widoczne są punkty 
wyłącznie z aktualnej akwizycji. Każdy nowy 
przebieg zastępuje poprzednio zarejestrowany w 
danym kanale. 

■ Poświata nieskończona akumuluje punkty z 
rekordu w sposób ciągły, dopóki nie zostaną 
zmienione nastawy wyświetlania. Używane jest to 
do wyświetlenia punktów, mogących wystąpić 
poza normalna akwizycją z obwiednią. 

■ Poświata regulowana gromadzi punkty z rekordu 
przez określony czas. Każdy punkt rekordu 
zanika niezależnie, zgodnie z ustalonym czasem 
poświaty. 

 
 

1. W celu określenia czasu poświaty należy 
wybrać Display > Display Persistance > 
Persistance Controls.... 

2. Kliknij Variable, Persist Time I posługując się 
pokrętłem wielofunkcyjnym ustal czas poświaty. 
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Ustawienia formatu ekranu 
Przyrząd może wyświetlać przebiegi w dwóch różnych formatach. Wybierz format, który najlepiej pasuje do 
wymagań. 

Wybierz Display > Display Format. 

■ Wybierz format Y-T aby pokazać zmiany 
amplitudy sygnału w czasie. 

■ Wybierz format X-Y aby porównać amplitudę 
Ch1(X) i Ch2(Y), Ch3(X) i Ch4(Y), Ref1(X) i 
Ref2(Y) lub Ref3(X) i Ref4(Y) przebiegów punkt 
po punkcie. 

 

 
 

Szybka podpowiedź 

■ Format XY jest użyteczny podczas badania zależności fazowych, takich jak krzywe Lissajous. 

■ Format XY wyświetlany jest tylko w trybie punktowym dot-only, Przy wybraniu formatu XY, wybranie 
wyświetlania w trybie wektorowym nie daje efektu. 

 

Wybór interpolacji przebiegu 
Wybierz Display > Waveform interpolation i 
następnie wybierz jedno z poniższych: 

■ Interpolacja Sin(x)/x oblicza punkty w rekordzie 
używając dopasowanych krzywych pomiędzy 
zgromadzonymi próbkami. 

■ Interpolacja liniowa oblicza punkty w rekordzie 
łącząc zgromadzone próbki liniami prostymi. 
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Szybka podpowiedź 
■ Interpolacja Sin(x)/x jest domyślnym trybem interpolacji. Do dokładnego przedstawienia przebiegu wymaga ona 

zgromadzenia mniejszej ilości próbek niż interpolacja liniowa. 

 

Dodawanie tekstu na ekranie 

1. Wybierz Display > Screen Text.  

 

 

2.   Wprowadź do ośmiu niezależnych linii tekstu. 

3. Kliknij Display aby wyświetlić lub wyłączyć 
tekst 

4. Kliknij Properties aby otworzyć okno 
właściwości tekstu, aby określić pozycję tekstu 
na ekranie. 

5. Kliknij Clear aby skasować wprowadzony tekst 
w wybranej linii. 

 

 
Szybka podpowiedź 
■ Aby zmienić pozycję tekstu na ekranie można kliknąć i przesunąć go. 
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Ustawienia stylu podziałki 
 

Aby określić styl podziałki wybierz Display > 
Graticule Style i następnie wybrać jeden z 
poniższych stylów: 

 

Używany w celu szybkiej 
oceny parametrów sygnału. 

 

Używany do pełnoekranowych 
pomiarów kursorami i 
automatycznych odczytów, 
gdzie linie podziałki są 
niepotrzebne. 

 

Używany do szybkiej oceny 
przebiegów, gdzie większy 
obszar pozostawiony jest na 
odczyty pomiarów 
automatycznych i inne dane. 

 

Używany z odczytami 
automatycznymi i innym 
tekstem ekranowym. 

 

Używany dla sygnałów 
wizyjnych NTSC 

 

Używany dla sygnałów 
wizyjnych, innych niż NTSC. 
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Ustawienia markera poziomu wyzwalania 
1. Wybierz Display > Objects.…  

2. Wybierz jedno z poniższych: 

■ Short wyświetla strzałkę na podziałce 

■ Long wyświetla linie poziomą wzdłuż 
podziałki 

■ Off wyłącza marker poziomu wyzwalania 

 

 

Wyświetlanie daty i czasu 
1. Wybierz Display > Objects.… 

2. Włącz wyświetlanie daty I czasu. Do ustawienia 
daty I czasu wybierz menu Utilities.  
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Wykorzystanie palety kolorów 
Wybierz Display > Record View Palette lub 
FastAcq/WfmDB Palette i następnie wybierz 
jeden z poniższych schematów kolorów dla 
przebiegu i podziałki: 

■ Normal wyświetla poziom jasność i 
nasycenia najbardziej odpowiednie dla 
większości obserwacji. Kolor przebiegu 
każdego kanału odpowiada kolorowi 
pokrętła na przednim panelu. 

■ Gradacja temperaturowa wyświetla na 
czerwono obszary przebiegu o większej 
gęstości próbek. Obszary o mniejszej 
gęstości pozostają niebieskie. 

■ Jednokolorowy zielony wyświetla obszary 
przebiegu o większej gęstości próbek w 
jaśniejszym odcieniu zieleni. Obszary o 
gęstości mniejszej są wyświetlane w 
ciemniejszym odcieniu. Przypomina to 
najbardziej ekran oscyloskopu 
analogowego. 

 

 

 

■ Gradacja widmowa wyświetla obszary 
przebiegu o większej gęstości próbek na 
niebiesko. Obszary o gęstości mniejszej 
są czerwone. 

■ Jednokolorowy szary wyświetla obszary 
przebiegu o większej gęstości próbek w 
jaśniejszym odcieniu szarości. Obszary o 
gęstości mniejszej pozostają ciemniejsze. 

■ Opcja User, pozwala wyświetlać 
przebiegi zgodnie z paletą barw 
zdefiniowana przez użytkownika. 

 

 

 

Szybka podpowiedź 
■ Aby wyświetlać obszary przebiegu o różnej gęstości próbek w różnych kolorach należy wybrać Display > Color i 

zaznaczyć jedną z palet z gradientem koloru. 

■ Są dwie palety kolorów, jedna dla akwizycji FastAcq/WfmDB i jedna dla Record View. 
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Ustawienia kolorów przebiegów referencyjnych 
Wybierz Display > Colors..., a następnie 
wybierz jedno z poniższych: 

■ Default używa domyślnych kolorów dla 
przebiegów referencyjnych. 

■ Inherit używa dla przebiegów 
referencyjnych tych samych kolorów co 
dla oryginalnych. 

 

 

Ustawienia kolorów przebiegów matematycznych 
Wybierz Display > Colors..., a następnie 
wybierz jedno z poniższych: 

■ Default używa domyślnych kolorów dla 
przebiegu matematycznego. 

■ Inherit używa dla przebiegów 
matematycznego takiego koloru jak dla 
kanału o najniższym numerze spośród 
tych, na podstawie których przebieg 
matematyczny został określony. 

 

 

 

 

Szybka podpowiedź 

■ Domyślnie dla przebiegów matematycznych i referencyjnych stosowane są odmienne kolory. 

 

Wykorzystanie funkcji MultiView Zoom 
Aby powiększyć przebieg w osi pionowej poziomej lub obydwu, należy użyć funkcji MultiView Zoom. Powiększone 
przebiegi mogą być wyrównywane lub automatycznie przewijane. Skala i pozycja odnoszą się jedynie do ekranu, 
nie zaś do przebiegu. 

 

1.  Wciśnij MultiView Zoom aby podzielić 
ekran i dodać podziałkę powiększonego 
przebiegu. 
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2.   Wciśnij HORIZ lub VERT aby wybrać którą 
oś powiększyć. Skalę i pozycję 
powiększonego przebiegu można 
regulować pokrętłem wielofunkcyjnym. 

 

 
3. Aby określić rozmiar powiększonej 

podziałki wybierz z menu Vertical lub 
Horiz/Acq wybierz Zoom Graticule Size. 

4. Aby wyłączyć powiększenie, wciśnij 
przycisk na przednim panelu. 

 

 
Szybka podpowiedź 
■ W celu zmiany rozmiaru podziałki przebiegu powiększonego można także użyć menu Zoom Setup. 

 

 

 

 

 

 

 

 

 

 

 

 

Główna podziałka 
Podziałka powiększona 
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Powiększanie kilku obszarów 
 Jeżeli  zachodzi potrzeba obserwacji i porównania wielu obszarów jednego przebiegu w tym samym czasie, należy: 

1. Kliknij i przeciągnij pole wokół obszaru 
przebiegu, który ma być powiększony. 

2. Zaznacz Zoom 1 On. 

 

 
 

3. Kliknij i przeciągnij pole wokół innego 
obszaru przebiegu i wybierz Zoom 2 On.  

 

 
 

4. Aby określić stopień powiększenia w osi 
poziomej kliknij poziomy marker poniżej 
powiększonego pola aby zaznaczyć 
powiększany obszar. 

5. Używając pokrętła wielofunkcyjnego ustaw 
pozycje poziomą i współczynnik 
powiększenia zaznaczonego obszaru. 
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6. Aby określić pionowy współczynnik 
powiększenia wybierz  Vertical > Zoom 
Setup..., kliknij pole pionowe a następnie 
używając pokrętła wielofunkcyjnego ustaw 
pozycję i współczynnik powiększenia. 

 
 

 

Szybka podpowiedź 
■ Aby wyczyścić powiększony obszar, kliknij Position Factor Reset w oknie Zoom Setup. 

■ Poprzez nastawy w oknie Zoom Setup można włączać i wyłączać każdy z powiększonych obszarów. 

■ Aby włączyć lub wyłączyć wszystkie powiększone obszary kliknij przycisk MultiView Zoom. 

■ Aby zmienić pozycję poziomą powiększonego obszaru, kliknij i przemieść poziomy marker u dołu   
   powiększonego pola. 
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Blokowanie i przewijanie przebiegów powiększonych 
1. Aby skorzystać z funkcji blokowania i 

przewijania, należy wybrać Zoom Setup... 
z menu Vertical lub Horiz/Acq i potem 
wybrać zakładkę Lock znd Scroll. 

 

 
2. W celu przewijania pojedynczego obszaru 

powiększonego, należy zaznaczyć pole 
wyboru Zoom 1-4 i kliknąć przycisk Auto 
Scroll. 

 

 
3. Aby przewijać wiele powiększonych 

obszarów jednocześnie należy kliknąć 
Lock i zaznaczyć pola wyboru Zoom 1-4, 
które mają być razem przewijane  . 

Zablokowanie powiększonych obszarów 
unieruchamia ich względną pozycję 
poziomą. Zmiana poziomej pozycji 
dowolnego przebiegu powiększonego i 
zablokowanego zmienia ją także dla 
pozostałych zablokowanych obszarów. 

  

 
Szybka podpowiedź 

■ Jeżeli zaznaczonych jest wiele obszarów powiększonych i nie zablokowanych, przewijanie automatyczne 
autoscroll odnosi się do obszaru o najwyższym numerze. Pozycja pozostałych pozostanie niezmieniona. 
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Analiza przebiegów 
 

Oscyloskop wspomaga analizę przebiegów dzięki kursorom, pomiarom automatycznym, statystykom, 
histogramom, przebiegom matematycznym, analizie widmowej i zaawansowanym testom typu pass/fail. Sekcja ta 
opisuje zasadę działania i sposób wykorzystania analiz przebiegów. Informacje szczegółowe dostępne sa w 
systemie pomocy online przyrządu. 

 

Wykonywanie pomiarów automatycznych 

1. Wybierz Measure > Measurement 
Setup.… 

 

 
 

2. Wybierz kanał, przebieg matematyczny 
lub referencyjny, do którego odnosić się 
będą pomiary. 

3. Używając zakładek, wybierz pomiary z 
pięciu różnych kategorii. 
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4. Wybierz Clear aby skasować ostatnio 
używane pomiary. 

5. Aby skasować wiele pomiarów, kliknij i 
przeciągnij wybrane pomiary a następnie 
wybierz Clear. 

 

 

 
Dla wybranego przebiegu, pomiary można 
także wybrac bezpośredni z menu 
Measure. (zobacz str. 50, Wybór pomiarów 
automatycznych). 

 

 
 

 
 

 Szybka podpowiedź 

■ W trybie przewijania pomiary automatyczne są niedostępne do momentu zatrzymania akwizycji. 
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Wybór pomiarów automatycznych 
Poniższa tabela zawiera zestawienie pomiarów automatycznych według kategorii: amplitudowe, czasowe, 
dodatkowe, histogramy i komunikacyjne (zobacz str. 48, Wykonywanie pomiarów automatycznych). 

Pomiary amplitudowe 

Pomiar Opis 

Amplitude Górna wartość minus dolna wartość, mierzone dla całego przebiegu lub bramkowanego 
obszaru. 

High Wartość górnego poziomu odniesienia, traktowana jako 100% w pomiarach czasu narostu lub 
opadania. Może być określona metodą histogramu lub min/max. Min/max wyznacza 
najwyższą wartość w przebiegu. Metoda histogramu wyznacza wartość najczęściej 
występującą powyżej poziomu średniego. Wartość mierzona dla całego przebiegu lub 
bramkowanego obszaru. 

Low Wartość dolnego poziomu odniesienia, traktowana jako 0% w pomiarach czasu narostu lub 
opadania. Może być określona metodą histogramu lub min/max. Min/max wyznacza 
najmniejszą wartość w przebiegu. Metoda histogramu wyznacza wartość najczęściej 
występującą poniżej poziomu średniego. Wartość mierzona dla całego przebiegu lub 
bramkowanego obszaru. 

RMS Wartość skuteczna dla całego przebiegu lub bramkowanego obszaru. 

Max Typowo największa dodatnia wartość napięcia dla całego przebiegu lub bramkowanego 
obszaru. 

Min Typowo najwyższa ujemna wartość napięcia dla całego przebiegu lub bramkowanego 
obszaru. 

Pk-Pk Wartość absolutna różnicy pomiędzy maksymalną a minimalną amplitudą, mierzona dla 
całego przebiegu lub bramkowanego obszaru. 

Cycle RMS Wartość skuteczna mierzona dla pierwszego okresu przebiegu lub bramkowanego obszaru. 

+Overshoot ((Maximum – High) / Aplitude) x 100% mierzone dla całego przebiegu lub bramkowanego 
obszaru. 

-Overshoot ((Low – Minimum) / Amplitude) x 100% mierzone dla całego przebiegu lub bramkowanego 
obszaru. 

Mean Arytmetyczna wartość średnia dla całego przebiegu lub bramkowanego obszaru. 

Cycle Mean Arytmetyczna wartość średnia dla pierwszego cyklu przebiegu lub bramkowanego obszaru. 

Pomiary czasowe 

Pomiar Opis 

Rise Time Czas, w którym zbocze narastające pierwszego impulsu przebiegu lub bramkowanego 
obszaru narasta od dolnego (domyślnie 10%) do górnego (domyślnie 90%) przebiegu. 

Fall Time Czas, w którym zbocze opadające pierwszego impulsu przebiegu lub bramkowanego obszaru 
opada od górnego (domyślnie 90%) do dolnego (domyślnie 10%) przebiegu. 

Pos Width Odległość (czas) pomiędzy punktami na poziomie odniesienia (domyślnie 50%) impulsu 
dodatniego. Wartość mierzona dla całego przebiegu lub bramkowanego obszaru. 

Neg Width Odległość (czas) pomiędzy punktami na poziomie odniesienia (domyślnie 50%) impulsu 
ujemnego. Wartość mierzona dla całego przebiegu lub bramkowanego obszaru. 

+ Duty Cyc Podany w procentach stosunek szerokości dodatniego impulsu do okresu przebiegu. Wartość 
mierzona dla pierwszego okresu przebiegu lub bramkowanego obszaru. 
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Pomiary czasowe (kontynuacja) 

Pomiar Opis 

- Duty Cyc Podany w procentach stosunek szerokości ujemnego impulsu do okresu przebiegu. Wartość 
mierzona dla pierwszego okresu przebiegu lub bramkowanego obszaru. 

Period Czas pierwszego okresu w przebiegu lub bramkowanym obszarze. Jest to odwrotność 
częstotliwości podawana w sekundach. 

Freq Częstotliwość pierwszego okresu przebiegu lub w bramkowanym obszarze. Jest to 
odwrotność okresu mierzona w Hz, gdzie Hz jest jednym okresem na sekundę.  

Delay Czas pomiędzy punktami dwóch różnych przebiegów na tym samym poziomie odniesienia 
(domyślnie 50%).  

Pomiary dodatkowe 

Pomiar Opis 

Area Pole ograniczone przebiegiem lub bramkowanym obszarem wyrażone w jednostkach Vs. Pole 
nad poziomem zerowym jest dodatnie, poniżej ujemne. 

Cycle Area Pole ograniczone przebiegiem w pierwszym cyklu wyrażone w jednostkach Vs. Pole nad 
poziomem odniesienia jest dodatnie, poniżej ujemne. 

Phase Różnica faz dwóch przebiegów; wielkość wyprzedzenia lub opóźnienia jednego przebiegu 
przez drugi wyrażana w stopniach. 360° oznacza jeden cykl. 

Burst Width Czas trwania paczki impulsów w całym przebiegu lub bramkowanym obszarze. 

Pomiary z wykorzystaniem histogramów 

Pomiar Opis 

Wfm Ct Wyświetla liczbę przebiegów uwzględnionych w histogramie. 

Hits in Box Wyświetla liczbę punktów w oknie histogramu lub granicach okna. 

Peak Hits Wyświetla liczbę punktów największej części histogramu. 

Median Wyświetla średni punkt okna histogramu. Połowa wszystkich zebranych punktów w oknie 
histogramu jest mniejsza od tej wartości a połowa większa. 

Max Wyświetla maksymalne napięcie histogramu pionowego lub maksymalny czas w histogramie 
poziomym. 

Min Wyświetla minimalne napięcie histogramu pionowego lub minimalny czas w histogramie 
poziomym. 

Pk-Pk Wyświetla rozpiętość histogramu. Histogramy pionowe wyświetlają napięcie najwyższej 
wartości niezerowej minus napięcie najniższej niezerowej wartości. Histogramy poziome 
wyświetlają czas skrajnej prawej, niezerowej wartości minus czas skrajnej lewej, niezerowej 
wartości. 

Mean Mierzy średnią ze wszystkich punktów zgromadzonych w oknie histogramu. 

Std Dev Odchylenie standardowe wszystkich punktów zgromadzonych wewnątrz okna histogramu. 

Mean ±1 Std Dev Procent punktów w histogramie, które mieszczą się w ramach jednego standardowego 
odchylenia od średniej. 
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Pomiary z wykorzystaniem histogramów (kontynuacja) 

Pomiar Opis 

Mean ±2 Std Dev Procent punktów w histogramie, które mieszczą się w ramach dwóch standardowych odchyleń 
od średniej histogramu. 

Mean ±3 Std Dev Procent punktów w histogramie, które mieszczą się w ramach trzech standardowych odchyleń 
od średniej histogramu. 

Pomiary komunikacyjne 

Pomiar Opis 

Ext Ratio Współczynnik górnego poziomu oka do podstawy. Pomiar ten dotyczy włącznie akwizycji 
Waveform database lub pomiarów referencyjnych zapisanych w tym trybie.  

Ext Ratio % Wyrażony w procentach współczynnik podstawy oka do poziomu górnego. Pomiar ten dotyczy 
włącznie akwizycji Waveform database lub pomiarów referencyjnych zapisanych w tym trybie. 

Ext Ratio (dB) Wyrażony w decybelach współczynnik górnego poziomu oka do podstawy. Pomiar ten dotyczy 
włącznie akwizycji Waveform database lub pomiarów referencyjnych zapisanych w tym trybie. 

Eye Height Pomiar wysokości oka w woltach. 

Eye Width Pomiar szerokości oka w sekundach. 

Eye Top Wartość górnego poziomu oka używana w pomiarach współczynników zaniku. 

Eye Base Wartość podstawy oka używana w pomiarach współczynników zaniku. 

Crossing % Punkt przecięcia oka wyrażony w procentach wysokości. 

Jitter P-P Międzyszczytowa wartość jitteru zbocza w aktualnych jednostkach skali poziomej. 

Jitter RMS Skuteczna wartość jitteru zbocza w aktualnych jednostkach skali poziomej. 

Jitter 6 Sigma Sześciokrotna wartość  skuteczna jitteru zbocza w aktualnych jednostkach skali poziomej. 

Noise P-P Międzyszczytowa wartość szumu poziomu górnego lub podstawy. 

Noise RMS Skuteczna wartość szumu poziomu górnego lub podstawy. 

S/N Ratio Współczynnik amplitudy sygnału do szumu poziomu górnego lub podstawy. 

Cyc Distortion Międzyszczytowe odchylenie czasu pierwszego przecięcia oka, mierzone na poziomie 
średnim Mid Ref w procentach okresu oka. 

Q-Factor Współczynnik rozmiaru oka do szumu. 
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Dostosowanie pomiarów automatycznych 
Pomiary autoamtyczne mogą być dopasowane do wymagań użytkownika poprzez wykorzystanie bramkowania, 
modyfikację statystyk pomiarów lub regulacje poziomów odniesienia. 

 

Bramkowanie 
 

Użycie bramkowania pozwala ograniczyć 
pomiary do wybranego fragmentu przebiegu. 

1. Wybierz Measure > Gating > Gating…. 

2. Wypozycjonuj bramkę wykonując jedno z 
poniższych: 

■   Kliknij Cursor aby zaznaczyć obszar 
bramkowania jako obszar pomiędzy 
kursorami. 

■   Kliknij Zoom (1-4) aby zaznaczyć 
obszar bramkowania powiększonej 
skali (1-4). 
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Statystyki 
 
Statystyki włączane są automatycznie wraz z 
pomiarami. Charakteryzują one stabilność 
pomiarów. 

1. Aby zmienić aktualnie wyświetlane 
statystyki należy wybrać Measure > 
Statistics, a następnie zaznaczyć Mean 
lub All. (All obejmuje min, max, mean, 
odchylenie standardowe i populację). 

2. Aby skasować statystyki należy wybrać 
Off.  

 

 

Poziomy odniesienia 
 
Poziomy odniesienia determinują wykonanie 
pomiarów czasowych. 

1. Wybierz Measure > Reference Levels.… 

2. Określ poziomy odniesienia pomiarów jako 
różne wartości względne lub absolutne. 

■   Górny i dolny poziom odniesienia jest 
używany do obliczania czasów 
narostu i opadania. Domyślny poziom 
wysoki wynosi 90% a dolny 10%. 

■   Poziom średni jest używany głównie 
przy pomiarach pomiędzy zboczami, 
jak szerokość impulsu. Poziom 
domyślny to 50%. 

■   Poziom Mid2 jest używany dla 
drugiego przebiegu, określonego 
przez opóźnienie lub w pomiarach 
fazy. Poziom domyślny to 50%. 

 

 

Szybka podpowiedź 

■   Aby zapewnić dokładny poziom szumów przy pomiarach diagramu oka, upewnij się, ze typ sygnału jest 
ustawiony na Eye. 
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Pomiary z wykorzystaniem kursorów 
Aby wykonać pomiary zgromadzonych danych można posłużyć się kursorami. 

 
1. Wciśnij Cursors.  

 

 

 

2. Wybierz źródło dla kursorów. 

3. Wybierz jeden z poniższych typów 
kursorów: 

■   H Bars mierzą amplitudę (typowo w 
woltach lub amperach) 

■   V Bars mierzą parametry poziome 
(typowo czas) 

■   Kursory przebiegów i ekranowe 
mierzą poziome i pionowe parametry 
jednocześnie. Kursory przebiegów 
dołączone są do przebiegów, kursory 
ekranowe są swobodne, 
niepołączone z przebiegiem. 
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4. W celu wykonania pomiarów pomiędzy 
dwoma przebiegami wybierz Waveform a 
następnie zaznacz przebieg źródłowy dla 
każdego z kursorów.  

 

 
5. Wybierz Cursors > Cursor Position... a 

następnie używając pokrętła 
wielofunkcyjnego wyreguluj pozycję 
kursora. 

6. Odczytaj z ekranu rezultat pomiaru 
kursorem. 

 

 
Szybka podpowiedź 

■   Aby dwa kursory przemieszczane były wspólnie użyj trybu Track Mode.  Tryb Independent Mode pozwoli 
przemieszczać kursory niezależnie. 

■   Jeśli używana jest skala powiększona, można umieścić kursor bezpośrednio na konkretnym punkcie przebiegu 
i wykonać dokładny pomiar. 

■   Kursory można także przemieszczać poprzez kliknięcie i przeciągnięcie do nowej pozycji. 

■   Kursor pionowy mierzy czas od punktu wyzwolenia do pozycji kursora. 
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Ustawienia histogramu 
Wyświetlać można zarówno histogram pionowy (napięcie) jak i poziomy (czas). Pomiary histogramowe pozwalają 
wykonać pomiary statystyczne fragmentu przebiegu wzdłuż jednej osi. 

 
1. Kliknij i przeciągnij punkt przez segment 

przebiegu który ma być uwzględniony w 
histogramie. Na przykład, dla histogramu 
poziomego wykonaj okno szersze niż jego 
wysokość. 

2. Zaznacz Histogram Vertical lub 
Histogram Horizontal z menu 
kontekstowego. 

 
3. Obserwuj histogram u góry skali 

(horizontal histograms) lub przy lewej 
krawędzi skali (vertical histograms). 
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4. Aby dostroić skalę histogramu lub jego 
rozmiar i położenie wybierz Measure > 
Waveform Histograms, a następnie użyć 
okna konfiguracji Histogram Setup. 

5. Można także wykonać pomiarów 
automatycznych na danych histogramu. 
(patrz str. 48, Wykonywanie pomiarów 
automatycznych.) 

 

 
Szybka podpowiedź 

■   Histogram pionowy pozwala zmierzyć szum sygnału, histogram poziomy zmierzyć jitter. 

■   Aby wyłączyć wyświetlany histogram  należy użyć procedury kliknięcia i przeciągnięcia uaktywniającej menu 
kontekstowe. 
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Wykorzystanie przebiegów matematycznych 
Przebiegi matematyczne wspomagają analizę przebiegów rejestrowanych lub referencyjnych. Poprzez połączenie i 
transformację przebiegów źródłowych i innych danych w przebiegi matematyczne, można obserwować dane 
wymagane w danej aplikacji. 

Aby skorzystać z predefiniowanych równań matematycznych należy użyć poniższej procedury. 

 
1. Wybierz Math > Math Setup.... 

 

 

 

 

2. Wybierz jedną z predefiniowanych 
zależności matematycznych. 

 

 

 
W celu określenia zaawansowanych wyrażeń matematycznych należy wykorzystać poniższą procedurę. 

1. Wybierz Math > Math Setup.... 
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2. Kliknij Editor.  

 

 

 
 

3. Zbuduj własne zaawansowane wyrażenie 
matematyczne wykorzystując, źródła, 
operatory, stałe, pomiary, zmienne i 
funkcje. 

4. Kiedy wyrażenie jest już gotowe kliknij 
Apply. 

 

 
 

5. W celu dołożenia własnego filtru, należy 
kliknąć zakładkę Filter a następnie kliknąć 
Load.  
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6. Kliknij podwójnie folder Math Arbitrary 
Filters. Następnie kliknij dwukrotnie filtr, 
który ma być użyty. 

 

 

 

 
 

7. Określ wyrażenie matematyczne z 
wykorzystaniem wybranego filtra. 

8. Kiedy wyrażenie jest już gotowe kliknij 
Apply. 

 

 
 

Szybka podpowiedź 
■   Definicje matematyczne nie są implementowane kiedy źródła nie są poprawne. 

■   Przebiegi matematyczne mogą być tworzone z kanałów, przebiegów referencyjnych, pomiarów i przebiegów 
źródłowych przebiegów matematycznych. 

■   Pomiary na przebiegach matematycznych mogą być wykonywane w ten sam sposób jak dla przebiegów w 
kanałach. 

■   Skala i pozycja przebiegów matematycznych są związane z ich przebiegami źródłowymi. Zmiana parametrów 
przebiegów źródłowych spowoduje także zmianę przebiegów matematycznych. 

■   Za pomocą funkcji MultiView można powiększyć przebiegi matematyczne; obszar powiększony można 
pozycjonować za pomocą myszki. 
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Wykorzystanie analizy widmowej 
Użyj poniższej procedury aby skorzystać z predefiniowanych, widmowych wyrażeń matematycznych. Szczegółowe 
informacje znajdują się w systemie pomocy online. 

 
1. Wybierz Math > Math Setup.... 

 

 

 

 

2. Wybierz jedno z predefiniowanych 
widmowych wyrażeń matematycznych. 

3. Kliknij Basic. 

 

 
4. W celu regulacji wyświetlanego widma kliknij 

Resolution BW lub Frequency Span i uzyj 
klawiatury lub pokrętła wielofunkcyjnego. 
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Aby zbudować zaawansowane widmowe wyrażenie matematyczne wykonaj poniższą procedurę. 

 
1. Wybierz Math > Advanced Spectral.…  

 

 

 

 
 

2. Zaznacz przebieg matematyczny, który 
chcesz zdefiniować. 

3. Kliknij typ przebiegu widmowego, który 
chcesz stworzyć. Aby ponownie 
definiować przebieg kliknij Clear. 

4. Zaznacz przebieg źródłowy. 

5. Używając kontrolek z okna konfiguracji 
Spectral Setup oraz pokrętła 
wielofunkcyjnego dostrój przebieg 
widmowy. 

 

 

 
 

 
 

6. Można obserwować jednocześnie 
przebiegi w dziedzinie czasu i 
częstotliwości.  

Aby wykorzystać analizę widmową tylko 
wybranego odcinka przebiegu w dziedzinie 
czasu wybierz Gating. (zobacz str. 53, 
Bramkowanie.) 
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Szybka podpowiedź 
■   Źródłem dla przebiegów widmowych mogą być przebiegi z kanałów lub innych przebiegów matematycznych.  

■   W celu uzyskania szybszej odpowiedzi przyrządu użyj krótszego rekordu. 

■   Aby zwiększyć rozdzielczość w dziedzinie częstotliwości i zmniejszyć szum w odniesieniu do sygnału należy 
zwiększyć długość rekordu. 

■   Różne funkcje okien powodują różny kształt odpowiedzi filtru w widmie i w efekcie różna rozdzielczość pasma. 
Więcej informacji znajduje się w systemie pomocy online. 

■   Rozdzielczość pasma RBW wpływa bezpośrednio na szerokość bramki. Dlatego markery bramki w dziedzinie 
czasu przesuną się kiedy zmieni się ten parametr. 

■   Możliwe jest wyświetlanie liniowej skali amplitudy części rzeczywistej lub urojonej widma. Jest to użyteczne 
kiedy widmo obliczono offline i przetransformowano z powrotem na przebieg w dziedzinie czasu. 

 

Korzystanie z masek testowych 
Opcja masek komunikacyjnych MTM umożliwia porównanie badanego sygnału z predefiniowaną maską. Aby 
sygnał przeszedł pozytywnie test, musi zmieścić się w obszarze określonym przez maskę. Ogólnie maski są 
definiowane przez komitet standaryzacyjny jak ANSI. Aby wykonać test z użyciem maski należy: 

 
1. Wybierz Masks > Source…. 

 

 

 

 

 

 

2. Wybierz źródło sygnału. 

 

 

3. Kliknij zakładkę Masks. 
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4. Wybierz typ i standard. 

 

 

 

 

 
5. Kliknij Config w celu dostępu do okna 

konfiguracji Mask Configuration. Pozwala 
ono określić sposób wyświetlania maski i jej 
naruszenia oraz nastawy Autoset i Autofit. 

6. Kliknij  Masks aby powrócić do okna 
konfiguracji Mask Setup. 

 

 
7. Włącz Lock Mask to Wfm aby śledzić 

zmiany maski w nastawach pionowych i 
poziomych. 

8. Przełącz Hi Count na On aby podświetlić 
przekroczenie maski podczas testu. 

 
 

9. Kliknij Autoset aby automatycznie 
wyrównać przebieg wewnątrz maski, 
opierając się na charakterystyce sygnału 
wejściowego. 

10. Przełącz Autofit na On aby automatycznie 
pozycjonować przebieg po każdej 
akwizycji. 
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11. Kliknij zakładkę Tolerance i określ 
tolerancję. 

Tolerancja większa od 0% czyni test 
trudniejszy do przejścia, nastawy tolerancji 
poniżej 0% czynią test łatwiejszym do 
przejścia.  

Użyj nastawy 0% aby wykonać test zgodnie 
ze standardem. Aby zmienić margines testu 
zmień nastawy tolerancji. 

 

 

 
 

12. Wybierz zakładkę Pass/Fail Setup i 
następnie ustaw parametry pass/fail.  

13. Wybierz Pass/Fail Test Notifications. 
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14. Wybierz polaryzację testu. 

15. Przełącz Pass/Fail Test na On aby 
uruchomić test. 

16. Przelącz Repeat na On aby włączyć 
powtarzanie testu. 

 
 

17. Aby przeglądać wyniki testu kliknij 
Pass/Fail Results. 

18. Kliknij Pass/Fail Test na On aby uruchomić 
test. 

19. Kliknij Reset aby skasować przekroczenia 
maski. 

 

 

 

 
Szybka podpowiedź 
■   Jeśli sygnał nie znajduje się wewnątrz maski. Włącz Autoset aby wycentrować przebieg w masce. 
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MyScope 
 

MyScope umożliwia tworzenie własnych okien konfiguracyjnych, zawierających tylko te elementy regulacyjne, które 
są wykorzystywane. Zamiast przełączania pomiędzy wieloma oknami, wszystkie wykorzystywane elementy 
regulacyjne mogą być umieszczone w jednym oknie użytkownika. 

Sekcja ta zawiera procedury tworzenia i wykorzystania własnych okien konfiguracyjnych MyScope. Informacje 
szczegółowe znajdują się w systemie pomocy online. 

 

Tworzenie nowego okna MyScope 
 

1. Wybierz MyScope > New Control 
Window…. 

 

 

 

 

2. Kliknij symbol + aby rozwinąć daną 
kategorię. Elementy regulacyjne, które 
mogą być dodane do okna MyScope 
zawarte są w tych kategoriach. Nazwy 
kategorii odpowiadają paskowi menu w 
celu ułatwienia odszukania używanych 
elementów. 
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3. Kliknij element regulacyjny aby zobaczyć 
jego podgląd 

 

 

 

 
4. Kliknij dwukrotnie na kontrolce lub kliknij 

symbol + aby rozwinąć listę.  
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5. Zostaw puste te pola wyboru, które 
odpowiadają komponentom nie mającym 
się znaleźć w oknie MyScope. 

 

 

 

 

 
 

6. Kliknij i przeciągnij żądane elementy na 
okno MyScope. Przeciągany element 
zostanie zatrzaśnięty na najbliższej lokacji 
siatki po zwolnieniu przycisku myszy. 
Poprzez klikniecie i przeciąganie można 
potem zmieniać lokację elementów. 
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7. Kliknij New Tab aby dodać do okna 
MyScope nową zakładkę. Można 
umieszczać do ośmiu zakładek. 

8. Aby zmienić nazwę zakładki należy 
wykonać jedno z poniższych: 

■   Kliknij Rename Tab. 

■   Kliknij podwójnie zakładkę a następnie 
wprowadź nową nazwę. 

9. Kliknij User Pref... żeby określić 
preferencje użytkownika, które zostaną 
załadowane wraz z oknem użytkownika. 

 

 

 

10. Aby skasować kontrolkę należy wykonać 
jedno z poniższych: 

■   Zaznacz zakładkę a następnie kliknij 
Delete. Zakładka i wszystkie kontrolki 
zostana skasowane. 

■   Zaznacz element regulacyjny i kliknij 
Delete. Zaznaczony element zostanie 
skasowany. 

 

11. Kliknij Save a następnie wprowadź nazwę 
okna użytkownika MyScope lub użyj nazwy 
domyślnej. 

 

 

 

 

 
Szybka podpowiedź 
■   W celu zrekonfigurowania kontrolki, kliknij i przeciągnij ponownie do okna podglądu. Następnie zaznacz lub 

pozostaw puste pole wyboru, które odpowiadają umieszczanym lub kasowanym elementom. 

■   W celu zmiany kolejności zakładek, kliknij i przeciągnij zakładkę do nowej lokacji. 

■   Aby skasować kontrolkę, kliknij i przeciągnij ja do górnej połowy ekranu (poza okno MyScope). 
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Wykorzystanie okna MyScope 
Aby otworzyć utworzone uprzednio okno MyScope należy wykonać: 

 
1. Wybierz MyScope > Open Control 

Window... lub jedno z pięciu najczęściej 
używanych okien MyScope. 

 

 

 

2. Wybierz okno MyScope, które ma być 
użyte i kliknij Open. 

 

 
 

Aby wyświetlić aktywne okno MyScope należy wykonać: 

1. Wybierz MyScope > Current... lub kliknij 
MyScope w trybie paska zadań. (Okno 
użytkownika MyScope może pozostawać 
aktywne nawet wówczas, gdy nie jest 
wyświetlane.) 
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Aby edytować okno MyScope należy wykonać: 

 
1. Wybierz MyScope > Edit Control 

Window... 

 

 

 
 

2.   Zaznacz okno, które ma być edytowane i 
następnie kliknij Open. 

 

 

 

 

 

 
Szybka podpowiedź 
■   Niektóre funkcje regulacyjne w oknie MyScope mogą działać w inny sposób niż w oknie standardowym. 

Dokładne informacje podane są w systemie pomocy online. 

■   Okna MyScope mogą być kopiowane (pliki *.tcw) do innych przyrządów serii DPO7000. 
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Zapisywanie i odtwarzanie informacji 
Sekcja ta zawiera procedury zapisywania i odczytu obrazów ekranów i nastaw, zapisywania pomiarów, 
wykorzystania schowka oraz drukowania. Szczegółowe informacje znajdują się w systemie pomocy online. 

 

Zapisywanie zrzutów ekranowych 
 

1.  Wybierz File > Save lub Save As > Screen 
Capture.… 

 

 

 
2.   Jeżeli chcesz skonfigurować takie 

parametry jak paleta, widok, obraz lub 
format kliknij Options.... W przeciwnym 
razie przejdź do punktu 3. 
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3. Wybierz lokalizację, w której zrzut 
ekranowy ma być zapisany. 

4. Wprowadź nazwę pliku lub użyj 
domyślnej, następnie wybierz typ pliku. 

5. Kliknij Save. 

 

 

 

 

 
Szybka podpowiedź 
■   Aby szybko zapisać wiele zrzutów ekranowych, wybierz Set Front Panel Print Button to Save i kliknij przycisk 

Save. Teraz możesz zapisywać zrzuty ekranowe przyciśnięciem przycisku Print na przednim panelu. 

 

Zapisywanie przebiegów 

 
1. Aby zapisać przebieg wybierz File > Save 

lub Save As > Waveform.... 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Zapisywanie i odtwarzanie informacji 
 

DPO7000 Instrukcja użytkownika 
 
76

2. Kliknij Waveform. 

3. Jeśli chcesz skonfigurować takie 
parametry jak zakres danych w przebiegu, 
zakres danych w trybie FastFrame, 
szczegóły przebiegu, źródło i  miejsce 
docelowe danych kliknij Options.... W 
przeciwnym razie przejdź do punktu 4. 

 

 

 

 

 

 
4. Wybierz źródło. 

5. Przebiegi można zapisywać zarówno jako 
referencyjne w pamięci przyrządu lub tez 
jako pliki *.wfm w katalogu systemu 
Windows. Aby zapisać przebiegi jako 
referencyjne, wybierz Ref 1-4. Aby zapisać 
przebieg w pliku *.wfm wybierz lokalizację 
gdzie ma być plik zapisany. 

6. Jeśli zapisywany jest pli *.wfm, wprowadź 
jego nazwę lub użyj domyślnej. 

7. Kliknij Save. 

 

 

 

 

 
Szybka podpowiedź 
■   Aby zapisywać kolejne pliki bez konieczności podawania całej nazwy wybierz Auto-increment file name. 

■   Aby szybko zapisywać wiele przebiegów wybierz Set Front Panel Print Button to Save i kliknij Save. Teraz 
możesz zapisywać przebiegi poprzez naciśnięcie przycisku Print na przednim panelu. 
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Odtwarzanie przebiegów 

 
1. Wybierz File > Recall.... 

 

 

 

 
2. Kliknij Waveform. 

3. Zaznacz miejsce docelowe pliku, który 
będzie odczytany. 

4. Zaznacz przebieg do odtworzenia. 

5. Kliknij Recall. Kliknięcie Recall uruchamia 
przebieg referencyjny i aktywuje okno 
konfiguracji Reference Waveform. 

 

 

 
 

6. Aby dopasować przebieg referencyjny użyj 
elementów regulacyjnych okna Reference 
Waveform. Można tego dokonać także 
poprzez wybranie z menu File > 
Reference Waveform Controls.... 

 

 

 

 

 
Szybka podpowiedź 
■   Można zapisywać pliki w wielu różnych formatach ale odtwarzać można wyłącznie pliki *.set dla nastaw i *.wfm 

dla przebiegów. 
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Zapisywanie nastaw przyrządu 

 
1. Wybierz File > Save lub Save As > 

Setup.... 

 

 

 

 

 
2. Kliknij Setup. 

3. Wybierz lokalizację w której chcesz 
umieścić plik z nastawami. Nastawy 
można zapisywać w jednej z dziesięciu 
lokacji pamięci przyrządu lub jako plik *.set 
w katalogu systemu Windows. 

4. Wprowadź nazwę pliku lub użyj domyślnej. 
W tym celu można wykorzystać menu w 
formie klawiatury pop-up. 

5. Kliknij Save. 

 

 

 

 

 
Szybka podpowiedź 

■   Jeśli włączony jest panel dotykowy, użyj menu pop-up w celu szybkiej identyfikacji nazw nastaw. 

■   Aby zapisać kilka podobnych plików bez konieczności wprowadzania całych nazw, można skorzystać z funkcji 
Auto-increment. 

■   Aby szybko zapisać wiele nastaw należy wybrać Set Front Panel Print Button to Save i kliknąć Save. Teraz 
można zapisywać nastawy poprzez naciśnięcie przycisku Print na przednim panelu. 
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Odtwarzanie nastaw przyrządu 

 
1. Wybierz File > Recall.... 

 

 

 

 

 

 
2. Kliknij Setup. 

3. Zaznacz nastawy, które chcesz odtworzyć. 
Nastawy można odtworzyć z jednej z 
dziesięciu lokacji pamięci przyrządu lub z 
pliku w katalogu systemu Windows. 

4. Kliknij Recall. 

 

 

 

 

 

 
Szybka podpowiedź 

■   Można odtworzyć dowolne nastawy zapisane na dysku i następnie zapisać je w wewnętrznej pamięci nastaw 
przyrządu w celu szybszego dostępu. 
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Zapisywania pomiarów 

 
1. Wybierz File > Save lub Save As > 

Measurement.… 

 

 

 

 

 

 
 

2. Jeśli chcesz skonfigurować wyświetlane 
pomiary lub ich format kliknij Options.... w 
przeciwnym razie przejdź do punktu 3. 

 

 

 

 

 

 

 

 
3. Wybierz lokalizację, do której będą 

zapisane pomiary. 

4. Wprowadź nazwę pomiarów a następnie 
wybierz ryp pliku. 

5. Kliknij Save. 
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Kopiowanie wyników do schowka 
Aby określić zawartość i format obrazów, przebiegów lub pomiarów, które będą skopiowane do schowka Microsoft 
należy wykonać poniższą procedurę. 

 
1. Wybierz Edit > Copy Setup…. 

 

 

 

 

 

 

 

 

2. Kliknij zakładkę Images, Waveforms lub 
Measurements a następnie zaznacz 
odpowiednie opcje. 
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W celu skopiowania obrazów, przebiegów lub pomiarów należy wykonać poniższą procedurę. 

 
1. Wybierz element, który chcesz skopiować. 

2. Wybierz Edit > Copy lub wciśnij Ctrl +C. 

3. Aby wkleić element do aplikacji Windows 
wciśnij Ctrl + V. 
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Drukowanie 

 
1. W wykonania wydruku należy: 

 ■   Nacisnąć PRINT. 

 lub 

 ■   Wybrać File > Print . Jeśli jest to 
konieczne, można dokonać zmian 
orientacji strony w oknie konfiguracji 
wydruku. 

 

 

 

 

 

 

 

 

Elementy okien dialogowych drukowania oraz 
konfiguracji drukowania zależą od 
zastosowanej drukarki. 

2. Kliknij Page Setup... 

 

 

 

 

 

 

 

 
3. Zaznacz Screen-copy lub Banner. 

4. Wybierz parametry drukowania zależne od 
typu zastosowanej drukarki. 
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Uruchamianie programów aplikacyjnych 
 

Płyta CD z dodatkowym opcjonalnym oprogramowaniem (Optional ApplicationSoftware) zawiera próbne wersje 
(pięć uruchomień)  opcjonalnych aplikacji, które mogą być zainstalowane w przyrządzie. Dostarczają one, 
zależnych od danej aplikacji rozwiązań pomiarowych. Niektóre przykłady opisane są poniżej. Mogą być także 
dostępne dodatkowe pakiety. Więcej informacji można uzyskać na stronie internetowej producenta 
www.tektronix.com lub u lokalnego przedstawiciela firmy Tektronix. 

■   Opcja ET3 zawiera testy zgodności 10/100/1000 Base-T Ethernet. 

■   Opcja USB pozwala badać sygnały USB 2.0, zawiera ona maski testowe i testy parametryczne (tylko program). 

■   Opcja pomiarów mocy PWR pozwala szybko wykonac pomiary i analizę mocy rozpraszanej w impulsowych 
układach zasilania i elementach magnetycznych. 

■   Opcja PTM pozwala wyzwalać przyrząd sygnałami transmisji szeregowej oraz dekodować ośmio- i 
dziesięciobitowe protokoły. Dekodowanie dostępne jest we wszystkich modelach. 

■   Opcja LSA umożliwia wyzwalania i analizę protokołów CAN/LIN. 

■   Opcja MTM zawiera maski testowe dla sygnałów komunikacyjnych. 

 

 
Aby zainstalować aplikację należy postępować 
zgodnie z instrukcją do niej załączoną. Aby 
uruchomić program, wybierz Analyze a 
następnie wybierz aplikację. 
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Przykłady zastosowań 
Sekcja ta opisuje sposób użycia oscyloskopu w często spotykanych zadaniach pomiarowych. 

 

Wychwytywanie anomalii sygnału 
Jednym z najtrudniejszych zadań, z jakim musza zmierzyć się projektanci jest znalezienie przyczyny powstawania 
przypadkowych błędów. Jeśli znany jest typ poszukiwanych anomalii, odnalezienie i wydzielenie ich występowania 
jest proste dzięki odpowiedniej konfiguracji obwodu wyzwalania. Jednak, nie zawsze wiadomo, czego dokładnie 
należy szukać. Może to być zadanie czasochłonne i nużące, zwłaszcza przy niewielkiej ilości wykonywanych 
akwizycji, jak ma to miejsce w typowym oscyloskopie DSO. 

Oscyloskopy z luminoforem cyfrowym, wykonane w technologii DPX, odznaczają się trybem bardzo szybkiej 
akwizycji, nazywanym FastAcq. Umożliwia on odnalezienie anomalii sygnału już w kilka sekund czy minut, podczas 
gdy tradycyjny oscyloskop DSO potrzebuje na to samo zadanie kilka godzin lub nawet dni. 

Aby wychwycić przypadkowe anomalie należy wykonać poniższą procedurę. 

 
1. Zbadaj dany sygnał (w ogólnym przypadku 

jest on tym, o którym można sadzić, że jest 
przyczyną błędów). 

 

 
2. Wciśnij Autoset. 
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3.   Wybierz Display > Display Persistance > 
Infinite Persistance. W przykładzie tym 
badany jest sygnał zegarowy. Po 1-2 
minutowej obserwacji sygnału, ale przed 
odnalezieniem problemu gdzie indziej, 
przejdź do punktu 4. 

 

 
4. Wciśnij FastAcq. 

 

 

 

 

 

 

 
5. Odszukaj przypadkowe zakłócenia jak np. 

glitche występujące w sygnale. W 
przykładzie tym FastAcq pozwoliła 
odnaleźć dodatni glitch ≈300 ns już po 
kilku sekundach. 

   

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 



Przykłady zastosowań 

DPO7000 Instrukcja użytkownika 87

6. Aby wyzwolić przyrząd na glitchu 
znalezionym w punkcie 5, wybierz Glitch 
Setup.... 

7. Wybierz odpowiednie wartości 
wyzwalania. 

8. Kliknij Level a następnie ustaw poziom 
wyzwalania zgodnie z tym co zostało 
odnalezione w punkcie 5. 

9. Kliknij Width a następnie ustaw 
odpowiednią szerokość, zgodnie z 
parametrami zakłócenia z punktu 5. 

 

 
10. Przełącz E-mail on Trigger na On. (patrz 

strona 93, ustawienia e-maila) 

 

 

 

 

 

 

 
 

11. Wciśnij Single aby wyzwolić przyrząd na 
pojedynczym glitchu. 
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Wykorzystanie rozszerzonego pulpitu i architektury OpenChoice  
Często zachodzi potrzeba udokumentowania pracy laboratoryjnej w celu przyszłego wykorzystania. Zamiast 
zapisywać zrzuty ekranowe i dane przebiegu na CD lub do pamięci USB a następnie generować raporty, spróbuj 
wykorzystać architekturę OpenChoice do dokumentowania pracy w czasie rzeczywistym. 

Aby zrobić z przyrządu centrum procesu projektowania i dokumentacji wykonaj ponizszą procedurę. 

 
1. Zainstaluj w przyrządzie Microsoft Word 

lub Excel. 

2. Podłącz drugi monitor. (zobzcz str. 5, 
dodawanie drugiego monitora.) 

 

 
3. Uruchom Microsoft Word a następnie 

przeciągnij okno Worda na rozszerzony 
pulpit. 

 

 

 

 

 

 

 

4. Kliknij TekScope aby przywrócić aplikacje 
przyrządu. 
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5. Wybierz Edit > Select for Copy > Full 
Screen (bitmap). 

 

 
 

6. Wciśnij Ctrl + C. 

7. Kliknij na dokumencie Worda w miejscu 
gdzie chcesz umieścić zrzut ekranowy i 
naciśnij Ctrl + V. 

 

 

  

 
Szybka podpowiedź 
■   Przyrząd dostarczany jest z różnymi narzędziami programowymi OpenChoice, zaprojektowanymi w celu 

maksymalizacji efektywności pozostałych elementów środowiska projektowego. 

 

Wyzwalanie magistralą 
Przyrząd może być wyzwalany magistralami I2C, SPI lub opcjonalnie CAN. Oscyloskop może wyświetlać zarówno 
warstwę fizyczną (jako przebieg analogowy) jak i, dla wyzwalania CAN i LIN, warstwę protokołu (jako cyfrowy 
przebieg symboliczny). 

Aby ustawić wyzwalanie magistralą należy: 

 
1. Wybierz Trig > A Event (Main) Trigger 

Setup.… 
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2. Wybierz tryb i źródło wyzwalania A w 
zakładce A Event. 

 

 

 

 
3. Wybierz Trigger On aby określić 

zdarzenie wyzwalające. 

 

 

 

 

 

 
 

4. W zależności od ustawienia Trigger On 
konieczne może być wykonanie 
dodatkowych ustawień. 
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Wyzwalanie sygnałem wizyjnym 
Przyrząd obsługuje wyzwalanie sygnałami NTSC, SECAM, PAL oraz high definition. 

Aby wyzwalać polami sygnału wizyjnego należy: 

 
1. Wybierz Trig > A Event (Main) Trigger 

Setup.… 

 

 
 

2. Ustaw tryb i źródło wyzwalania A w 
zakładce A Event. 

 Wybierz Format > 525/NTSC. 

 

 

 
3. Wybierz Trigger On > Field. 

Wybierz Odd (nieparzyste), Even 
(parzyste) lub All (wszystkie) pola. 
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Wyzwalanie liniami 
Aby obserwować linię w polu, należy: 

 
1. Wybierz Trig > A Event (Main) Trigger 

Setup…. 

 

 
 

2. W zakładce A Event ustaw źródło i tryb 
wyzwalania A. 

Wybierz Format > 525/NTSC. 

 

 
3. Wybierz Trigger On > All Lines. 
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Konfiguracja wysyłania E-maila po zdarzeniu 

 
1. Wybierz Utilities > E-mail on event > 

Setup…. 

 

 

 

 
2. Wprowadź adres(y) a-mail odbiorcy. W 

przypadku kilku adresów należy oddzielic je 
przecinkiem. Ograniczenie w polu adres 
wynosi 252 znaki. 

 

 

3. Kliknij Config a następnie wprowadź adres 
serwera SMTP. W celu wpisania 
poprawnego adresu skontaktuj się z 
administratorem Twojej sieci. 
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4. Określ zdarzenie, które ma spowodować 
wysłanie e-maila. 

5. Aby dodać załącznik wybierz jego typ a 
następnie kliknij Settings aby określic 
format. 

 

6. Ustaw maksymalny limit wiadomości i 
rozmiar e-maila. (maksymalny limit 
wiadomości to 50 a maksymalny rozmiar 
wiadomości wynosi 2000 MB). Kiedy 
osiągnięty zostanie limit wiadomości należy 
kliknąć Reset aby móc wysłac więcej 
wiadomości. 

7. Aby upewnić się, że wprowadzony adres 
jest poprawny można wysłać wiadomość 
testową poprzez kliknięcie Send. 

8. Jeśli to konieczne kliknij Config aby 
uzyskać dostęp do okna dialogowego 
konfiguracji e-maila. 

 

 

 

 
Szybka podpowiedź 
■   Aby zapisać załącznik na dysku twardym przyrządu, należy ustawić maksymalny rozmiar wiadomości na zero. 

Załączniki będą zapisywane w domyślnej lokalizacji C:\TekScope\ScreenCaptures, Waveforms, lub Data, w 
zależności od typu załącznika. 
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Korelacja danych pomiędzy oscyloskopem Tektronix a analizatorem stanów 
logicznych 

Większą część każdego projektu stanowią układy dużej szybkości z bardzo stromymi zboczami zegara i dużej 
szybkości przepływu danych. W takich projektach zachodzi potrzeba obserwacji charakterystyki analogowej 
szybkich sygnałów cyfrowych w relacji do złożonych zdarzeń cyfrowych w układzie. IView jest oknem w analogowy 
i cyfrowy świat. Możliwości iView integrują i automatycznie korelują dane z oscyloskopu i analizatora widma firmy 
Tektronix tak, że można transferować przebiegi analogowe z oscyloskopu na wyświetlacz analizatora stanów 
logicznych jednym kliknięciem myszki. Obserwacja skorelowanych w czasie sygnałów analogowych i cyfrowych 
pozwala precyzyjnie ustalić źródło zakłóceń i glitchy. 

Zewnętrzny kabel iView pozwala połączyć oscyloskop z analizatorem stanów logicznych, umożliwiając 
komunikacje pomiędzy przyrządami. Dostępny w menu System analizatorów stanów logicznych TLA kreator 
połączeń, przeprowadza przez proces łączenia iView pomiędzy analizatorem stanów logicznych a oscyloskopem. 

Dostępne jest także okno ustawień pomagające zweryfikować, zmienić i przetestować nastawy oscyloskopu. Przed 
rozpoczęciem akwizycji i wyświetleniem przebiegu, konieczne jest ustanowienie połączenia pomiędzy analizatorem 
stanów logicznych Tektronix a oscyloskopem za pomocą kreatora połączeń. 

 
1. Wybierz Add iView External 

Oscilloscope... z menu system 
analizatora stanów logicznych. 

 

 

 
2. Zaznacz używany model oscyloskopu. 

3. Postępuj zgodnie z instrukcją na ekranie a 
następnie kliknij Next. 

4. Więcej informacji dotyczących korelacji 
danych pomiędzy analizatorem stanów 
logicznych a oscyloskopem znajduje się w 
dokumentacji Analizatora. 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

 


